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About Elicitus 

Welcome to Elicitus, a powerful tool for creating content-rich e-learning courses in HTML. 
After you  have designed a course, you can publish it through Elicitus in various ways – 
for viewing on CD  ROM or website or intranet, with AICC / SCORM compliance for 
deploying through a learning  management system. 
 
Elicitus helps you create complete e-learning experiences. Your course can be enriched 
with media  resources such as pictures, hyperlinks, video clips and sounds. You can 
create assessments and  exercises to judge the learner’s progress. Question banks can be 
created for creating exercises  and assessments quickly. You can choose to display 
corrective messages and scores to learners.  You can also create a multimedia glossary to 
help learners.  
You can do all this without any programming knowledge. 
 
Courses can be published with compliance to SCORM 1.2, SCORM 2004 or AICC 
Level 1  compliance. 
 

About Courses 

 
A course is what you create and publish with the help of Elicitus. It is the complete 
learning package  of a particular subject.  For example, English Grammar can be the 
subject of a course. 
 
A course can have several learning units. Each learning unit can have many lessons and 
each  lesson will have topic pages. The topic pages contain the content of the course. The 
entire course  can have a multimedia glossary created through Elicitus’s Glossary Builder 
 
A course can end with an assessment to check the learner’s understanding of the subject. 
 
Courses can be published with SCORM 1.2 compliance or AICC Level 1 compliance. 
 

About Course Outline Editor 

 
The Course Outline Editor allows you to design the Course Outline for the course. You can 
set the  attributes through Course Preferences. The interface of the Course Outline Editor 
is similar to the  Topic Page Editor. The size of the Course Outline is same as that of the 
desired output window size  selected in the Course Preferences 
 
- The Course Outline Editor shows all the objects that you have selected.  

 
- You can place objects on the page using drag and drop from the toolbar exactly as 

you do for  objects on the Topic page.  

 
- You can place picture, flash animation, text, button/hotspot, and hyperlink on the 

Course  Outline and also attach audio to the Course Outline.  

 

- In addition, you can place a box for Prerequisite and a box for Learning Objective in 
the Course  Explorer.  

 

- You can resize, insert and delete the controls on the Course Outline. 



About Learning Units 

 
Learning units are optional components of a course. A learning unit is one important 
stage in a  learner’s journey to understanding the subject of a course. For example, in a 
course on English  Grammar, understanding tenses would be an important learning 
unit. This learning unit will have  one or more lessons. 
 
It is advisable to create course as a group of learning units. That way, when you need to  
expand or  modify a course, you need to only add or change learning units; you need not 
spend time changing  the whole course. 
 
Every learning unit can end with an assessment to check the learner’s 
understanding of the  subject. 
 

About Lessons 

 
Lessons are essential components of any course. A lesson is one specific part of the 
subject matter  of any course to be learnt. For example, in a course on English Grammar, 
understanding present  tenses could be a lesson. 
 
Several related lessons can form a learning unit. You can, however, create courses 
without  learning units. 
 
Every lesson will have one or more topic pages. 
 

About Topic Pages 

 
A topic page is an essential component of any lesson in any course. It is what contains 
the actual  content of your course. For example, in a course on English Grammar, in a 
lesson on present  tenses, the simple present tense would be one topic page and the 
present continuous would be  another topic page. 
 
The topic page will contain the explanation of these concepts in text form. You can also 
provide  explanations with the help of images and animation clips and media resources such as 

sound and  video clips, hyperlinks, images and text files. You can insert various kinds of 
buttons in topic pages. 
 
A lesson will have one or more topic pages in a logical sequence. You can construct topic 
pages  easily in attractive and user-friendly ways by choosing from Elicitus’s over 200+ 
page design  templates. You can have one exercise for each topic page. 
 
Topic pages have topic toolbar icons such as Previous Topic, Next Topic, etc. You can 
modify  these icons. 
 

About Exercises 

An exercise is an optional component of a topic page, meant to assess the learner’s 
understanding  of the topic. Once an exercise is attached to a topic page, it will be 
displayed to the learner before  the learner goes to the next topic page. The learner can 
however quit from the exercise and go the  next topic page without doing the exercise. 
 



An exercise will have one or more questions. 
 
Question types you can use in Elicitus are such that each question can have only one 
correct  answer. Elicitus will check the learner’s answers. You can choose to display 
corrective messages to  the learner after wrong answers, and you can also choose to 
display a reinforcement text to the  learner, explaining the correct answer. The corrective 
messages and reinforcement text are  displayed immediately after the learner enters the 
answer, before the learner answers the next  question. 
 
Questions can include media resources such as sound and video clips and pictures. All 
questions  you create automatically become part of the question bank. You can also 
create a question bank  separately and then insert questions from it into exercises. 

 

About Questions 

 
Questions are essential components of any exercise or assessment. 
 
Question types you can use in Elicitus are such that each question can have only one 
correct  answer, which can be given a numerical score. Elicitus can check the learner’s 
answers and total up  scores of all answers in an assessment (Scores are not displayed in 
exercises). 
 
Elicitus allows you to create ten types of questions: 
 
1. Multiple choice questions: In this type, the learner has to choose one 

among several  alternatives as the correct answer.  

 

2. Fill in the blanks: In this type, the learner has to enter a word or a numeral in a 
blank provided  for the correct answer.  

 

3. True/False: In this type, the learner has to select whether the answer you have 
provided is  true  or false.  

 

4. Match the pairs: In this type, the learner has to select answers from the right 
column of a table  to correctly match the entries in the left column.  

 

5. Multiple correct answers: In this type, the learner has to choose the correct 
answer(s) among  the alternatives.  

 

6. Graphic choice:  In this type, the learner has to choose the graphic as correct 
answer among  the several alternatives provided.  

 

7. Drag and drop:  In this type, the learner has to drag images at the correct location 
on the drop  image.  

 
8. Visual identification:  In this type, the learner has to click the correct area on the 

screen.  

 
9. Multiple text entry:  In this type, the learner has to enter a word or numeral in 

multiple blanks  provided for the answers.  
 
 



 
 
10. Sequencing:  In this type, the learner has to arrange the choices in correct 

sequence.  
 

11. Fill in the blanks with wildcard question: A fill in the blank with wildcard question 
is created by specifying the text or numerical answer that has to be filled in the blank. 
The answer can be more than one word or numeral. For example it can be a phrase or 
a hyphenated number. The answer can not have '*' in it.  

 
You can attach media resources to questions. For example, you can ask the learner to 
read an  attached text and answer your questions on it, or you can ask the learner to look 
at a picture or hear  a sound and answer your questions on it. 
 
You can choose to display corrective messages to the learner, which will be displayed if 
the  answer entered by the learner is wrong. You can also choose to display a 
reinforcement message  to the learner, explaining the correct answer. 
 
You can give a hint and an additional hint to learners along with each or some questions. 
Any  question you create for any exercise or assessment is automatically added to the 
question bank of  the course. You can create a question bank of questions for a course 
and then pull out questions  from it to create exercises or assessments. 
 

About Question Bank 

 
A question bank of a course stores all the questions you have created while creating 
exercises or an  assessment for a course. You can also create a question bank separately. 
You can then pull out  questions from the question bank to create exercises or 
assessments. You can add, modify or  delete questions in the question bank by using the 
question bank editor. 
 

About Glossary Builder 

 
The Glossary Builder helps you create a glossary, which is an optional component of any 
course. 
 
The glossary can contain explanations of all special terms used in the course. The 
explanations can  be enriched with media resources. 
 
Glossary terms can be put under different glossary categories. For example, in a course 
on English  Grammar, glossary categories could be: Terms about Verbs, terms about 
Tenses, etc. 

 

 

 

 

 



About Assessments 

 
An assessment is an optional component of a course, meant to assess the learner’s 
understanding  of any learning unit or the whole course. An assessment can be 
understood as an exercise for a  learning unit or the whole course. However, unlike 
exercises for topic pages, assessments do not  become mandatory components after they 
are created. That is, the learner will be able to complete  a learning unit or a course 
without viewing its assessment. 
 
Questions in an assessment can have scores for correct answers. You can choose to 
display to  the learner the total scores for an assessment and the correct answers. 

 

About Media Resources 

 
Media Resources are sound, image, video, HTML, slide show (.pps or .ppt) or text files 
you can  attach to:  

Topic Pages 
Buttons or hot spots in topic pages   
Hyperlinked text in topic pages   
Questions 
Glossary terms  

  
An additional media resource available only for text in topic page is hyperlinks to 
websites. 
 
While sound, image, HTML, slide show or video files have to be already existing in your 
machine to  be attached as media resources, you can create text files in Elicitus and 
attach them to any of the  above. 

About Templates 

 
Elicitus provides over 200+ templates or page design formats for placing your content 
within topic  pages. Each template contains a maximum of three basic elements: 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
• a text box in which you can enter text 
• a title box in which have to specify the title of the topic page  
• a box for a picture  

 
In different templates the number of these boxes varies; the boxes are at different 
locations and in  different sizes. When you chose a template for a topic page you can 
change the number, size and  location of the boxes. 
 
 
You can choose to globally apply a default template for all topics in a course. If required, 
you can  modify this template in particular topic page. 
 
NOTE: You can enter text only in a text box; a title only in a title box, and a picture or 
flash animation  only in a box for this purpose. 
 

About Topic Toolbar Icons 

 
Topic pages have a topic toolbar with icons such as Previous Topic, Next Topic, etc. You 
can  modify this toolbar in various ways. For instance, you can delete an icon or change 
its image, or its  textual tool tip  (e.g., `Previous Topic’). 
 
Below are explanations of the functions of each topic toolbar icon: 
 
Previous Topic: Takes learner to previous topic page (disabled when learner is one 
first topic of  first lesson) 
 
Next Topic: Takes learner to next topic page (disabled on the last topic of the last 
lesson) 
 



First Topic of the Lesson: Takes learner to first topic page of the lesson (disabled on 
the first  topic) 
 
Last Topic of the Lesson: Takes learner to last topic page of the lesson (disabled on 
last topic) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Previous Lesson: Takes learner to previous lesson (disabled on first lesson). Note: If 
the course is  published with lesson level SCORM compliance or Lesson level Assignable 
Unit AICC Level 1  Compliance, the previous lesson option will not be valid. In this case, 
this icon will not be shown on  the toolbar even if you have selected it. 
 

Next Lesson: Takes learner to next lesson (disabled on last lesson). Note: If the course 
is  published with lesson level SCORM compliance or Lesson level Assignable Unit AICC 
Level 1  Compliance, the next lesson option will not be valid. In this case, this icon will 
not be shown on the  toolbar even if you have selected it. 
 
Jump to Topic: Takes learner to different topic 
 
Back: Takes learner to previously visited topic page 
 
Replay: Replays the whole page from the beginning 
 
Glossary: Opens Glossary 
 
Help: Opens online Help 
 



Course Outline: Takes learner to Course Outline, from which learner can go to any topic 
page. If  the course is published in slide show format, the learner will be taken to the 
first topic page of the  first lesson 
 
Quit: Closes the topic page 
 
Close All Videos: Closes all the videos (in AVI, MPG, MPEG format) that are opened on 
the Topic  page. 
 

About Question Toolbar Icons 

The questions in the assessments and exercises have a question toolbar with icons such as  

Previous Question, Next Question, etc. You can modify this toolbar in various ways. For 

instance,  you can delete an icon or change its image, or its textual tool tip  (e.g., `Previous 

Question’). 
 
Below are explanations of the functions of each topic toolbar icon: 
 
Next Question: Displays the following question (disabled on the last question) 
 
Previous Question: Displays the preceding question (disabled on the first question) 
 
Hint: Displays a hint to help the learner to answer the question 
 
Additional Hint: Displays additional hint if the first hint has not helped the learner to 
answer the  question 
 
Media Resource: Displays the media resource like sound, image, video, HTML, slide show 
(.pps or .ppt) or text files attached to the question 
 
Help: Opens the online help 
 
Quit: Closes the assessments and the exercises 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

About SCORM and AICC Compliance 

 
Any course you create in Elicitus can be published with compliance to SCORM 1.2, SCORM 
2004  compliance or AICC compliance. (For more information on SCORM compliance, visit  
www.adlnet.org and for more information on AICC, visit www.aicc.org) 
 
If you publish with SCORM 1.2 Compliance, the course has to be hosted on a SCORM 
compliant  LMS. 
 
When you choose to publish with SCORM 1.2 or SCORM 2004 compliance, you can 
publish with  either course level or lesson level SCO (Sharable Content Object). 
 
When you choose to publish with AICC Level 1 Compliance, you can publish with either 
course  level Assignable Unit or lesson level Assignable Unit. 
 
If the course is published with SCORM/AICC compliance and hosted on a SCORM or AICC  
compliant LMS, the LMS does the tracking. The last visited page is bookmarked. Thus, 
when the  learner goes back to the course, the learner has the option to go back to the 
last page visited. The  score for assessments is tracked and a user with administrative 
access to the LMS can see scores  of learners who have done assessments in the course. 
 
 



 

When published with SCORM 1.2 or SCORM 2004 Compliance, manifest file(s) are created for 

the  metadata of the course. When published with AICC Level 1 Compliance, four course 

structure files  are created. These files are used to import the course on AICC Level 1 

complaint LMS. 

About Import 

 
When you have different teams using Elicitus to author large e- learning content, the 
members may  have to work on the same course at different times resulting in 
inefficiencies of the teams. 
 
An ability to create courses, which act as parts of a bigger course and an ability to 
assemble the  course from these, facilitate simultaneous creation of parts of course by 
different authors. Elicitus  Import feature is designed to make this possible. 
 
 

CREATING A COURSE 
 

MANAGING COURSE 
 

Creating a Course 

 
Normally you will create a course in the following sequence of events: 

 
1. You will structure your course and organize all its content. (You will perform this 

task outside  Elicitus  
 
2. You will create a new course identity in Elicitus.  
 
3. You may the structure the course by creating learning units.  
 
4. You may specify global formatting for the course – formatting that will apply to 

every topic  page – as also output settings – how the learner will view the course.  
 
5. You will specify the different lessons in the course.  
 
6. You will create topic pages of each lesson.  
 
7. You may create a Question Bank for the course.  
 
8. You may attach exercises to any or all topic pages.  
 
9. You may create a glossary for the course.  
 
10. You may create an assessment for learning units or for the entire course.  
 
You may then publish the entire course. 
 
Note that some of the above steps are not mandatory. For instance, you can choose not 
to create a  glossary, a question bank or learning units. However, in all cases, steps 2, 5 
and 6 have to be  followed to create a course. You have to create a new course identity 
and at least  one lesson with at  least one topic page to publish a course. 
 
 



 

Note also that you can perform the above steps in a different sequence to some extent. For  

example, you may create a new course identity and then proceed to create the course’s 

question  bank; or you may create all topic pages and then specify global formatting for all the 

topic pages.  However, in all cases, you have to perform step 2 (create a new course identity) 

before you perform  any other task in Elicitus related to a new course. Also, you have to create 

lessons before you  create topic pages and you have to create topic pages before you create 

exercises for topic pages. 
 
 
For help on any of the steps above except 1, which is outside Elicitus, see the relevant 
topics in this  online help. 

New Course Wizard 

The New Course Wizard helps you create the basic hierarchy of the course as learning 
units,  lessons, and assessments. It also lets you set the default settings for the course. 
The New Course  Wizard guides you through the course creation process. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1. On the first screen, the wizard confirms the choice for creating a new course. You can 

choose to  use New Course Wizard for creating a course or you can choose to create a 
blank course.  

 

2. Selecting New Course Wizard takes you through the new course wizard for course 
creation.  Click OK to proceed. Clicking OK shows the welcome screen for the 
wizard;  click 'Next' to  proceed. If you wish to create a course in any non-English 
language supported by Unicode,  click 'Locale Settings'. (See also: Course Locale 
Settings)  

 
3. Enter the Course Name, Author Name and select the course folder by clicking on 

'Browse'  button. Click 'Next' to proceed. A message is shown to confirm the course 
creation path.  

4. Enter the number of learning units you want to create in the course. It is 
recommended that you  start with creation of one or two learning units. You can 
increase or decrease the number of  learning units by clicking on the up or down 
arrows in the text entry box or by directly entering  the number. By default, two 
learning units are created. You can choose to create a blank course  by entering zero 
(0) as number of learning units.  



Maximum 99 learning units can be created.  Click 'Next' to proceed.  

 
5. Clicking 'Next' shows the screen for accepting the learning unit details. Enter the learning 

unit  title and number of lessons and assessments that need to be created within the 

learning unit.  By default, two lessons and one assessment is created in each learning 

unit. Each lesson  contains one topic page whereas; the assessments are blank without 

any questions.  

 

6. As you enter the learning unit details, the explorer on left of the dialogue shows the 
hierarchy as  it is built up. Click 'Next' to proceed.  

 
7. After entering the details about all learning units, it asks for the Course Display Settings.  

Choose the size of the desired output window as 800 x 600 or 1024 x 768. Default is 800 x 
600.  

 
8. Select the position for course display relative to learner's screen as Center or Top Left. 

By  default, the course is shown in center relative to learner's screen. Click 'Next' to 
proceed.  

 

9. Enter the Topic Settings. Select the default font for topic title and topic text by 
clicking the  'Change' button.  

 
10. Select the Topic Title Alignment as Left, Center or Right. By default, title is aligned to 

center.  

 

11. Select the default background. To select the background, click the Change button against 
the  Background Settings. It opens the dialogue box for selection of background image or 
color.  

   
12. Click the Background Change button, and click Plain Color or Image or No wallpaper.  
 

• To select a Plain color wallpaper:   
In the Select Wallpaper window, click the Plain color background as wallpaper 
option. Click  the desired color in the color dialog box OR create a custom color by 
clicking the Define  Custom Colors button. The Preview pane shows you the 
selected color.  

 
 

• To select a Picture as wallpaper:   
In the Select Wallpaper window, click the Picture background as wallpaper option. 
Search  for an appropriate image file (.bmp, .icon, .gif, .jpg, .dib or .emf) by 
clicking the Browse  button. The Preview pane shows you the selected image.   
Click OK.  

 

• To select wallpaper from Elicitus readymade wallpapers:   
In the Select Wallpaper window, click the Elicitus readymade wallpapers option. 
Select an  appropriate wallpaper by clicking the filename in the list. The Preview 
pane shows you the  selected image.   
Click OK.  

 

13. Select the default template by clicking Change button. Click 'Next' to proceed.  
 
 
 
 



 
14. Select the Assessment Settings. Uncheck the checkbox 'Display answers after 

assessments' if  you do not want to show the answers to the learner after 
assessment.  

 
15. Uncheck the checkbox 'Display assessment score' if you do want to disable display 

of score  after assessment.  

 
16. If you want to email score to the administrator, select the Email score to the 

administrator option  and specify the Email address of the administrator to which the 
score needs to be sent. Click  'Next' to proceed.  

 
17. Click 'Finish' to complete the course creation process. You can anytime change the 

course  settings by clicking 'Back'. Verify the course hierarchy in the course explorer 
view on the left  before confirming the course creation.  

 

18. Clicking on 'Finish' starts the course creation. It may take few seconds. Once 
the course is  created, Elicitus shows the complete course hierarchy in course 
explorer with the specified  number of learning units, lessons and assessments and 
topic pages.  

 

19. Once the course is created, you can add more learning units, lessons, 
assessments, topic  pages, questions, glossary terms and glossary categories to it. 
The sequence of learning units,  lessons, assessments can be changed. For more 
information, please refer to the respective  help topic.  

Creating a New Course Identity 

 
A new course identity is created by specifying the name of the course and its author. The 
first can  be 100 characters long (e.g. Understanding Afro-American Music) and the 
second can be 150  characters long (e.g. John Malkovich). The course is saved as a .eli 
file with the name of the course  as the file name. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
To create a new course: 

 
1. In the File menu click New OR Click New Course icon on the toolbar.  
 
2. Enter Course Name. The name can be 100 characters long.  
 
3. Enter name of the Author of the course. The name can be 150 characters long.  
 
4. Select the folder where you want to save the course.  
 
5. Click Save  

 
You can now:  
• Specify global formatting for every topic in the course.   
• Specify output settings for the course.  
 

Opening a Course 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
You can modify the topic toolbar in the following ways:  
• You can remove any icon. For instance, you can remove Next Lesson and Jump to 

deliberately  limit the learner’s navigation.   
• You can increase the space between the icons.   
• You can change the textual tool tip of icons. For instance, you can change `First 

Topic’ to  `Introduction’.   
• You can change the appearance of the icon images. You can specify that the image 

should be  displayed only when the mouse is moved over it (mouseover image), or it 
should not be  displayed (disabled image), or it should be displayed only when the 
learner clicks on it   (clicked image).   

• You can change the icon images with images that exist in your machine. For instance 
you can  change the Help icon image to the image of an exclamation mark you have 
created.   

• You can change the size of the icon images. The default size is 24 x 24 pixels. You can 
change  it to 16 x 16 pixels or 32 x 32 pixels, or any custom size.   

• You can change the position of the icons in the toolbar. For instance you can move 
the Replay  icon so that it appears just above the Quit icon.   

• You can change the position of the toolbar from its default top left position. You can 
position the  toolbar at top center, top right of the topic page.  

To modify the topic toolbar: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window click Course Preference OR in the main-menu click  

Settings,  then click Course Preferences from pop-up menu.  
 
4. In the Course Preferences window,  under Toolbar Settings click Topic Page Toolbar.  
 
You may now: 
 

Remove an icon by selecting the icon (uncheck its box) 
 

Increase the space between two icons by clicking the first icon and selecting Space 1, 
Space 2,  Space 3, Space 4 or Space 5, to increase the space between the selected 
icon and the icon that  follows by one, two, three, four or five lines respectively. 

 
Change the appearance of an icon image by clicking the icon and selecting in the 
Select  Images box MouseOver Image, Disabled Image or Clicked Image 

 
Change the position of an icon by clicking it and dragging it to the icon before which 
you want it  to appear. For instance, if you want Previous Topic to appear before Next 
Topic,  click Previous  Topic and drag it and it place it on Next Topic. 

 
Change the textual tool tip of an icon by double clicking the icon and typing the new 
text. 

 
Change an icon image by clicking the icon and clicking Select in the Select Images 
box. A  Select Image window opens. Click the file of your choice. Then specify the 
appearance of the  icon image by selecting MouseOver Image, Disabled Image or 
Clicked Image (uncheck options  you don’t want) and click OK. 

 
 



 
 
Change an icon image’s size by clicking the icon and selecting 16 x 16 or 32 x 32 
(pixels) in the  Image Size box. To specify custom size, select Custom and enter 
Height and Width in number  of pixels. 

 
Change the position of the toolbar itself by selecting the position in the Toolbar 
Position  window. For instance, if you want the toolbar to appear in top center 
position, select the second  button (under Center) in the first (Top) row. 

 
You may now preview the changed Topic Toolbar by clicking Preview Toolbar. A sample 
topic  page displays with changed Topic Toolbar 
 
5.   Click Apply Topic Toolbar Settings. To cancel all settings you have made click Cancel. 

Modifying the Question Toolbar 

 
The Question Toolbar Settings section enables the author to: 
 
• Select icons for the Question Toolbar   
• Determine/change the sequence of the icons   
• Determine/change the size of the icons   
• Change the position of the Question Toolbar  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
You can modify the Question Toolbar in the following ways: 
 
• You can remove any icon.   
• You can increase the space between the icons.   
• You can change the text tool tip for the icons.   
• You can change the appearance of the icon images. You can specify that the image 

should be  displayed only when the mouse is moved over it (Mouseover image) or 
that it should not be  displayed (disabled image), or that it should be displayed only 
when the learner clicks it (clicked  image).   

• You can replace the icon images with images saved on your machine. For instance, 
you can  change the Help icon image to the image of an exclamation mark you have 
created.  

• You can change the size of the icon images. The default size is 24 x 24 pixels. You can 
change  it to 16 x 16 pixels or 32 x 32 pixels, or any custom size.   

• You can change the position of the icons in the toolbar. For instance, you can move 
the Media  Resource icon so that it appears just below the Additional Hint icon.   

• You can change the position of the toolbar from its default position. You can position 
the toolbar  at the left, center or right of the page.  

To modify the Question Toolbar: 

 
1. Click either Open in the File menu or the Open Course icon on the toolbar.  
 
2. Click the course file name.  
 
3. In the Course Explorer window, click Course Preferences. Alternatively, in the main 

menu,  click Settings and then click Course Preferences on the popup menu.  
 
4. In the Course Preferences window, under Toolbar Settings, click Question Toolbar.  
 
You may now: 

 
• Remove an icon by selecting the icon (clear the checkbox).   
• Increase the space between any two icons by clicking the first icon and 

selecting Space  1, Space 2, Space 3, Space 4 or Space 5 to insert a space of 
one, two, three, four or  five lines respectively between the selected icon and 
the following icon.   

• Change the appearance of an icon image by clicking the icon and selecting in 
the  Select Images box MouseOver Image, Disabled Image or Clicked Image.   

• Change the position of an icon in the sequence of icons by clicking it and 
dragging it to  the icon before which you want it to appear. For instance, if you 
want Media  Resource  to  appear  before  Additional  Hint,  click  Media  
Resource  and  drag  and  drop  it  on  Additional Hint.   

• Change the text tool tip of an icon by double clicking the icon and typing the new 
text.   

• Change an icon image by clicking the icon and clicking Select in the Select 
Images box.  A  Select  Image  window  opens.  Click  the  file  of  your  
choice.  Then  specify  the  appearance of the icon image by selecting 
MouseOver Image, Disabled Image or  Clicked Image (clear the appropriate 
checkboxes) and click OK.   

• Change an icon image’s size by clicking the icon and selecting any of the 
following  options in the Image Size box: 16x16, 24X24 or 32x32 (pixels). To 



specify custom size,  select Custom and enter the Width and the Height as the 
number of pixels.   

• Change the position of the toolbar by selecting the position in the Toolbar 
Position box  from the following options: Left, Center, and Right.  

 
5. You may now preview the changed Question Toolbar by clicking the Preview Toolbar  
button.  This displays a sample page with the modified Question Toolbar.  
 
6.     Click the Apply Question Toolbar Settings button. To cancel all settings, click Cancel.  

Specifying Global Formatting for a Course  

 
Elicitus applies the following default global formatting to all topic pages in a course:  
• Title Font: Arial 14. Color: Black   
• Text Font: Arial 10. Color: Black   
• Background: No background  
 
This is the default template for all topic pages. However you can change these default 
attributes. 
 
Note: If you change the global attributes after creating some topic pages, the new 
formatting will  apply only to the pages you create after you have changed the 
attributes. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

You can globally apply: 
 
• Another font, font size, font style (bold, italics) and font color to all topic titles and all topic 

text.  
 
 
 



  
• A background color or wallpaper to all topic pages.   
• Another template for all topics page layouts, choosing from Elicitus’ over 200+ 

templates.  

 
NOTE: Any global formatting can be removed while creating a topic page. For instance if 
you select  a global background color for all topic pages before you create topic pages, 
you can  choose another  color for specific pages, while creating these pages. 
 
To specify global formatting for all topics in a course: 

 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name..  
 
3. In the Course Explorer window click Course Preferences OR in the main-menu click 

Settings,  then click Course Preferences from pop-up menu.  
 
4. In the Course Preferences window, click Topic Settings.  
 

You may now:   
Specify a font style for the title and text of topic pages.  Specify a color for the title 
and text of topic pages.  Apply a background for every topic page.  Select another 
template for all topic pages  
 

 
To specify a font for the title of topic pages:  

 
• Under Topic Title Font option, on right side of the screen, click the font Change 

button,  and select the type and size of the font. If you want the font to be bold, 
select bold.If you  want the font to be italics, select italics.  

 
To specify a color for the title of topics: 

 
• Under Topic Title Font option, on right side of the screen, click the color Change 

button,  and click a color for the topic title.  
 

To specify the alignment of the title of topics: 
 

• Under Topic Title Alignment option, select the title alignment as Left, Center or 

Right.  To specify the font for the text of topics:  
 

• Under Topic Text Font option, on right side of the screen, click the font Change 
button,  and click the type and size of the font. If you want the font to be bold, 
select bold.If you want  the font to be italics, select italics.  

 
To specify a color for the text of topics: 

 
• Under Topic Text Font option, on right side of the screen, click the color Change 

button,  and click a color for the topic text.  
 

 

To apply a background for topic pages:  
O Click the Background Change button, and click Plain Color or Image or No 
wallpaper. 

 
 

 

 



 

To select a Plain color wallpaper: 

  
In the Select Wallpaper window, click the Plain color background as wallpaper option. 
Click the  desired color in the color dialog box OR create a custom color by clicking 
the Define Custom  Colors button. The Preview pane shows you the selected color. 

 
To select a Picture as wallpaper: 

  
In the Select Wallpaper window, click the Picture background as wallpaper option. 
Search for  an appropriate image file (.bmp, .icon, .gif, .jpg, .dib or .emf) by clicking 
the Browse button. The  Preview pane shows you the selected image.  
Click OK. 

 
To select default template for all topic pages: 

  
Click the Template Change button, and click a template from 200+ pre-defined templates.  

 
5. After specifying the above, click Apply Topic Settings OR click Cancel to cancel the 

selection  and close the window.  

 
NOTE: After step 5 you may proceed to specify output settings and then click the 
Apply All  Settings button. 

Specifying Output Settings 

 
Elicitus applies these default output settings, which determine how the learner views a 
course: 

  
• Screen resolution: 800X600   
• Course display window position in learner’s screen: Center   
• Do not display course in slide show format. The course will open on the learner’s 

screen with  the course outline, and the learner will have to click on lessons/topics to 
view them.   

• Display all default topic page toolbar icons with toolbar to top left of page  

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can however change these settings and add some new ones:  
• You can select a different screen resolution. You can choose from 800 x 600 to 1024 x 766  

pixels or set a custom resolution. The custom resolution can be minimum 575 X 430. You 
have  to choose the resolution before creating a topic page or question in assessment / 
exercise or  creating a Drag and Drop or Visual Identification question; you cannot change 
it later.   

• You can select the position of the course display window as top left of the learner’s 
screen.   

• You can choose to display the course in a full screen (slide show) format. In this case, 
the  course will open on the learner’s screen with the first topic of the first lesson. In 
this  option, the  learner will not be able to view assessments.   

• You can choose not to display correct answers of assessments and the learner’s 
score in  assessments.   

• You can choose to display a video or animation sequence at the beginning of the 
course.   

• You can modify the topic toolbar to suit your requirements. For instance, you can 
delete some  icons or change the icon images, or the textual tool tip (e.g., `Previous 
Topic’) of the  icons. (For  explanations of the functions of default icons see About 
Topic Toolbar Icons).  

 
 
 



 
NOTE: All output settings except the screen resolution can be changed while publishing the 
course. 
 

 

To specify output settings for a course: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window click Course Preference OR in the main-menu click  

Settings,  then click Course Preferences from pop-up menu.  
 

4. In the Course Preferences window,  click Output Settings.   
 

You may now:  
Set the screen resolution for the course. Under Course Display Settings, select 
screen  resolution in terms of pixels, by clicking 800x600 or 1024x768.  
Change the position of the Course display window to top left of screen. Under 
Course  Display Settings, click Top Left.  
Display the course in a slide show format. Under Course Rendering Style, select 
Display  the Course in Slide Show Format.  
Select video clip for opening of a course. Under Visual Settings, click Select Video, 
then  click the video /flash movie file.  
Modify the topic page toolbar 

 
5.   After specifying the above, click Apply Output Settings. 
 
Click Cancel to cancel all selections and close the window. 
 
NOTE: After step 4 above, you may proceed to specify global formatting for topics of the 
course and  then click the Apply All Settings. 

Specifying Assessment Settings 

 
Elicitus applies these default assessment settings, which determine how the 
assessments will be  rendered: 
 
• Display learner’s score after assessments   
• Display correct answers after assessments   
• Do not email score to the administrator  
 
You can however change these settings and add some new ones: 
 
• You can choose not to display correct answers of assessments and the learner’s 

score in  assessments.  
 
To specify assessment settings for a course: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window click Course Preference OR in the main-menu click  

Settings,  then click Course Preferences from pop-up menu.  
 
 



 
 
4. In the Course Preferences window, click Assessment Settings.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You may now: 
 
Enable the email score to administrator. To do so: 
 
1. Select the Email score to the administrator option and specify the Email 

address of the  administrator to which the score needs to be sent.   
2. Click the Apply Assessment Settings button.  
 
Click Cancel to cancel all selections and close the window. 

Modifying a Course 

 
You can open a course and modify any of the following:  
• Any learning unit and its sequence   
• Any lesson and its sequence   
• Any topic and its sequence   
• Any exercise   
• Any question in any exercise or question bank   
• Any assessment   
• Any term or category in the glossary   



 
You can also open a course and delete any learning unit, lesson, topic, exercise, 
question in an  exercise, assessment or the question bank, or any glossary term or 
category. 

Saving a Course 

 
To save a course:  
On the main menu, in the File menu, click Save. 
 

Spelling Check 

 
Elicitus allows you spell check your text in the course. The spell check uses the default 
dictionary of  the MS word for spell checking. You can check the spelling on current open 
dialogue. 
 

 
 
To start the spelling check, Click Tools-->Spelling menu or press F7. This will open the 
spelling  check dialogue. The dialogue shows the incorrect spelling and below it shows the 
suggested  spelling. Select the appropriate spelling and click Change button to correct it. 
Click Ignore to ignore  the suggested change. 
 
NOTE: For the spelling check to work, you need to have MS word installed on your 
machine. 
 

Zip the course: 

Elicitus allows you ZIP the published course using ZIP course option. To zip a course, you 
need to first publish it. You can then zip any of the published courses.    

 

 



 

To ZIP the course, Click Tools-->ZIP Course menu. This will open the Zip course dialogue. 
Select the destination path where you want to store the zipped file. Enter the name of the 
ZIP file. Select the published output you want to ZIP. The dialogue shows the list of all 
the published formats for the currently opened course.   

 

By default, the ZIP file takes the name of the sub-folder within publish folder based on 
which course output you want to zip and the zip file is stored in the publish directory of 
the course.  

Find and replace text: 

Elicitus allows you to find and replace text in your course. You can decide to find and 
replace the text in current editor, current lesson, current learning unit, selected control or 
whole course. The search criteria can be searching the whole word only. You can also find 
the text with case sensitive option ON. When you choose to find the text in current 
lesson, current learning unit or whole course, you have an option of searching in Up, 
Down or All the directions.    

Clicking on Replace button opens another option where you can type the text which you 
want to replace the found text with. Replace All replaces all the text which is found by 
find option and the changes done by Replace All cannot be undone.  



 

To start the text Find, Click Edit-->Find menu or press Ctl + F. This will open the find 
dialogue. Type the text you want to Find. Clicking on Find Next button will find the next 
instance of the typed text.   

NOTE: Replace will replace the found text which is shown as selected. If you select a 
different text than the one found by Find option, the whole selected text will get replaced. 

MANAGING COURSE OUTLINE 

 
For an overview of this topic, see About Course Outline Editor 
 
Course Outline Editor allows you to modify the course outline page of the course. 

   
To open the Course Outline Editor: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click Course Outline Editor.  
 
The Course Outline Editor has following options in the toolbar. 
 

Attach Auto Audio: Allows you to attach the audio in *.wav, *.mp3, *.mid, *.ram, 
*.rm formats. The  audio starts as soon as the Course Outline is shown. The audio is 
played only once and is not  looped. 
 
Attach Wallpaper: Clicking this icon opens the dialogue for changing/attaching the 
wallpaper to the  Course Outline. You can set the default wallpaper through Course 
Preferences. 

 
Add Button: You can add a button to the Course Outline using this icon just as you do in 
the Topic  Page Editor. 

 
Set Button Properties: Allows you to set button/hotspot properties as well as the 
Glossary and Finish  Course link properties. 
 



Preview: Gives you the Preview of the Course Outline. 

 
Add Course Explorer: Allows you to insert a Course Explorer. There can be only 
one Course  Explorer on the Course Outline Page. 

 

Add Prerequisite Placeholder: Allows you to insert the placeholder for Prerequisite.  

Add Learning Objective Placeholder: Allows you to insert the placeholder for 

Learning Objective. 

 
Add Welcome Message: Allows you to insert the Welcome Message, which can be 
shown in one  color and one font. The Course Outline can contain only one box of 
Welcome Message, with a  maximum of 250 characters. You can edit the Welcome 
Message. There can be only one Welcome  Message. 

 

Add Glossary Link: Clicking this icon allows you to insert the link, which opens the 
Glossary in a new  window. There can be only one Glossary link on the Course Outline 
page. On double clicking the  image for Glossary link, you get an option to do the settings 
for the Glossary link. 
 
Under settings, you can set the Image, MouseOverImage and the Tool Tip for the 
Glossary link. 

 

Add Finish Course Button: Allows inserting the Finish Course Button. When the learner 
clicks on the  Finish Course Button, it finishes the course by closing the window. If the 
course is opened in the  same window as that of the Learning Management System 
(LMS), clicking on Finish Course Button  does not perform any visible action. It only sends 
the data to the LMS. However, if the course is  opened in a new window other than that 
of the LMS, clicking Finish Course Button closes the  Course window and sends the data 
to the LMS. You can add only one Finish Course Button on the  Course Outline page. 

 
On double clicking the Finish Course Button, you get an option to do the settings for the 
Finish  Course link. Under settings, you can set the Image, MouseOverImage and also the 
Tool Tip for the  Finish Course button. 
 
Add Text: Allows you to insert a text box. 
 
Add Picture: Allows you to insert a picture placeholder. 
 
Add Flash Animation: Allows you to insert a placeholder for Flash Animation. 

 

Delete Control: Allows you to delete the selected control.  Cancel Selection: Allows you 

to cancel the current selection. 

 
Set Attributes: Allows you to set the left, top, height and width attributes of the 

selected control.  Save: Saves the settings. 

 
Help: Displays help. 
 

Course Explorer 
 



The Course Explorer is like a placeholder, which shows the complete Course hierarchy. 
 
The Course Explorer has a ‘Font Settings’ button in the bottom right corner, which allows 
you to set  the font and color of the Titles of different nodes for the Learning Unit, Lesson, 
Assessment and  Topic page. The font settings can be previewed in the preview mode. 
 
You cannot add/delete any node in the Course Explorer. It contains all the Learning Units, 
Lessons,  Assessments, and Topic pages in the course. 
 
The Course Outline page can contain only one Course Explorer. 
 
Select the option Show the course explorer fully expanded to show the course structure in  
completed expanded form in the course explorer on the course outline page. If you don’t 
select this  option, the course structure is shown expanded till the lesson level. 
 
Prerequisite and Learning Objective 
 
The Course Outline can have placeholders for the Prerequisite and the Learning Objective. 
You are  not allowed to insert any text or image in these placeholders. 
 
These placeholders show the Prerequisite and Learning Objective of the Learning Unit, 
Lesson or  Assessment, whichever the learner has clicked. 
 
The placeholder has a ‘Font Settings’ button in the bottom right corner, which allows you 
to set the  font and color for the Prerequisite and Learning Objective. There can be only 
one font and one color  for the Prerequisite and Learning Objective. 
 
You can see the Learning Objective and Prerequisite by clicking on Learning Unit, Lesson 
or  Assessment only when the Learning Unit, Lesson or Assessment has the Learning 
Objective and  Prerequisite. Otherwise, the Learning Objective and Prerequisite boxes 
are not shown. 
 
You can also copy the objects and format the objects on course outline similar to that of topic 
page. 
 
To cancel the previous action, click the Undo icon and to repeat the previous action, click 
the Redo  icon. 
 

MANAGING LEARNING UNITS 

Creating Learning Units 

 
For an overview of this topic see About Learning Unit 
 
A learning unit is created by giving it a name (title). You can specify the learning 
objectives of the  unit and its pre-requisites: the knowledge a learner must have to 
understand the lessons in the  learning unit. 
 
Learning units of a course are sequenced in the order you create them. You can 
change this  sequence. You can also modify or delete learning units. 
 
 
 



 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To create a new learning unit: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, right-click Course Contents, and click Add Learning 

Unit from  the popup menu OR  
 
4. In the main menu, click Design, click Learning Unit from the popup menu and then 

click Add  New Learning Unit from the sub-menu.  
 
5. A window for creating a new Learning Unit of the Course opens.  
 
6. In the window, click Learning Unit and enter Learning Unit Title. Title can be 100 

characters  long.  
 
7. For example, ‘Introduction to Photoshop’ can be used as a Title for a Learning Unit in 

a course  on Photoshop.  
 
8. Click Learning Objective and enter the Learning Objective in brief.  
 
9. Click Prerequisite and enter prerequisite. For example, study a course in 

programming, the  learner should be aware of basic logic building concepts.  
 
10. Click Save. The information provided is saved and the Learning Unit window will close.  
 
 



11. Click Cancel to disregard all information provided, and close the Learning Unit 
window.   

Modifying a Learning Unit 

 
To modify a learning unit: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Learning Unit which is to be modified.  
 
4. The right hand pane will display the Learning Unit in the edit mode.  
 
5. Make the desired changes to the Learning Unit.  
 
6. Click Save.  

Deleting a Learning Unit 

 
To delete a learning unit: 
 
 
 
 
 
 
 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Learning Unit which is to be deleted.  
 
4. In the right hand pane, which displays the Learning Unit in the edit mode, click 

Delete.  
 

OR In the Course Explorer window, right-click the Learning Unit to be deleted, and 
click Delete Learning Unit from the pop-up menu. 

 
OR In the main menu, click Design, and click Learning Unit from the pop-up menu, and 
click Delete Learning Unit from the sub-menu. 

  
A message box confirming deletion is displayed. 

 
5.   Click Yes to confirm OR click No to cancel the deletion. 
 

Changing the Position of a Learning Unit 

 
To change the position of a learning unit in a course, you have to select the learning unit 
in Course  Explorer window and, with the help of your mouse, place it on the position of 
the learning unit before  which you want it to appear.  
 
For example, if you have four learning units and you and you want to  place Learning Unit 
4 after Learning Unit 1 and before Learning Unit 2, you should select Learning  Unit 4 and 
drag it and drop it on Learning Unit 2. 
 
If you want to move a learning unit to the last position in a course, drag the learning unit 
and drop it  on Course contents 
 
To reposition the order of learning units that are defined in a course: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name..  
 
3. In the Course Explorer window, click on the Learning Unit to be moved, and drag and 

drop the  Learning Unit to the desired position.  
 

MANAGING LESSONS 
 

Creating Lessons 

 
For an overview of this topic see About Lessons 
 
A lesson is created by giving it a name (title). You can specify the learning objectives of 
the lesson  and its pre-requisites; i.e., the knowledge a learner must have to understand 
the topics in the  learning unit. 
 
Lessons of a course are sequenced in the order you create them. You can change this 
sequence.  You can also modify or delete lessons. 



 
Lessons can be sequenced under learning units. If you have not created learning units, 
lessons  have to be sequenced under the course name. You can subsequently assign a  
lesson created  directly under a course to a learning unit in that course. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To create a new lesson of a course: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name. You can now add a lesson directly to a course OR add a 

lesson to a  learning unit in a course.  
 
3. To add a lesson directly to a course:  

 

In the Course Explorer window, right-click Course Contents, and click Add Lesson 
from the  popup menu  

 
OR In the Course Explorer window, click Course Contents and, from main menu, click 
Design.  From the popup menu, click Lesson and from the sub-menu click Add New 
Lesson.  

 
To add a lesson to a learning unit in a course:   
In the Course Explorer window, right-click Learning Unit, and then from the pop-up 
menu click  Add New Lesson in this Learning Unit  

 



 
OR In the Course Explorer window, click Learning Unit and then in the main menu click 
Design.  In the pop-up menu click Lesson and then from the sub-menu click Add New 
Lesson.  

 
A window for creating a new Lesson of the Course opens. 

 
4. In the window, enter Lesson Title. Title can be 100 characters long. For example, 

‘Basic HTML  tags’ can be used as a Title for a Lesson in a Course on HTML  
 
5. Enter Learning Objective in brief. For example, in a Lesson with the Title ‘Basic HTML 

tags’,  Learning Objectives could include a list of tags covered in the Lesson.  
 
6. Enter Prerequisite. For example, the prerequisite for a Lesson titled ‘Basic HTML tags’ 

could  be ‘Knowledge of any word processing tool’.  
 
7. Click Save. The information provided is saved and the Lesson dialog will close.  

 
Click Cancel to delete all information provided and exit the Lesson dialog. 

Modifying a Lesson 

 
To modify a lesson: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Lesson which is to be modified. The right 

hand pane  will display the Lesson in the edit mode.  
 
4. Make the desired changes to the Lesson.  
 
5. Click Save.  

Deleting a Lesson 

 
NOTE: When you delete a lesson, all its topic pages and exercises are deleted. 



 

 
 

To delete a lesson: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Lesson which is to be deleted. Then in the 

right hand  pane, which displays the Lesson in the edit mode, click Delete.  

 
OR 
 
In the Course Explorer window, right-click the Lesson to be deleted and, from the pop-
up  menu,  click Delete Lesson.  
OR  
In the Course Explorer window, click the Lesson that is to be deleted. In the main menu, 
click Design. Then from the pop-up menu click Lesson and, in the sub-menu  click 
Delete Lesson. A message box confirming deletion is displayed. 
 
4.   Click Yes to confirm OR click No to cancel the deletion. 
 
 



Assigning a Lesson of a Course to a Learning Unit 

 
To assign a lesson, created directly under a course, to a learning unit in that course: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  A List of Lessons in the Course are displayed in the Course 

Explorer  window.  
 
3. Click on the Lesson to be grouped under a Learning Unit. Drag and drop to the 

required  Learning Unit.  
 

Changing the Position of a Lesson 

 
To change the position of a lesson in a learning unit or course, you have to select it in 
Course  Explorer window and, with the help of your mouse, place it on the position of the 
lesson before  which you want it to appear. For example, if you have four lessons in a 
learning unit or course and  you and you want to place Lesson 4 after Lesson 1 and 
before Lesson 2, you should select Lesson  4 and drag and drop it on Lesson 2. 
 
If you want to place a lesson at the end of a learning unit, drag it and drop on the 
learning unit. 
 
If you have not created learning units and you want to place a lesson at the end of 
a course,  drag and drop the lesson on the Course contents 
 
To change the order of lessons in a learning unit or course: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click on the Lesson to be repositioned, and drag and 

drop the  Lesson to the desired position.  
 

MANAGING TOPIC PAGES 

Creating Lesson Master Topic Page 

  
The lesson master topic page is the master topic page for each lesson which has all the 

common  objects on all topic pages in the lesson. Objects like picture, flash animations, 

text boxes, buttons/  hotspots placed on the lesson master topic page are shown on all 

topic pages in that lesson. You  can improve the course creation productivity by placing 

all the objects which appear on all topic  pages on the lesson master topic page. 

Modifying the object properties on the lesson master topic  page modifies the object for 

all associated topic pages in that lesson. 

 

Lesson master topic page is created with the creation of Lesson. 
 
1. To view or edit the lesson master topic page, click on the lesson in course explorer 

and select  the link 'Master Topic Design' at the bottom of the screen or select the 
menu  Design-->Lesson-->Master Topic Design.  

 



2. By default, all the topic pages in the lesson are associated with the lesson master 
topic page.  When the topic pages are associated with the lesson master topic page, 
all the objects on  lesson master topic page appear on the topic page. You cannot 
edit the objects from the lesson  master topic page on the respective topic page.  

 
3. However, any topic page can be disassociated from the lesson master topic page by 

clicking  "Disassociate" icon on the toolbar. When the topic page is disassociated, the 

objects from the  lesson master topic page are not shown on the topic page. The topic 

page can be again  associated with the lesson master topic page by clicking the 

"Associate" icon on the toolbar.  

 

4. Clicking on the icon "Associate all topic pages" on the lesson master topic page 
associates all  the topic pages in the lesson with lesson master topic page.  

 

5. By default, as soon as the lesson is created, when you start designing lesson master 
topic page,  you can either start by using one of the standard templates or with the 
blank layout. You can  place the objects like Text, Picture, Flash Animation, Title and 
Button etc. on lesson master  topic page by clicking on respective icons on the toolbar 
or selecting the respective menu. You  can attach the auto audio or auto video to 
lesson master topic page which will get associated  with all topic pages in that lesson.  

 

6. You can define the background for the lesson master topic page. When you change 
the  background, it confirms whether to apply the background to all topic pages or 
only associated  topic pages or only to newly created topic pages. Selecting "Apply to 
all topic pages" applies the  background to all associated as well as disassociated 
topic pages. Selecting the option of  applying the background to only the new topic 
pages applies the background only to the topic  pages created after the design of 
lesson master topic page. At anytime later, you can change  the background of the 
topic page.  

 
7. If the lesson master topic page does not have any background, it takes the default 

background  which is set through topic settings.  

 

8. The title on the lesson master topic page is shown on all topic pages. You can change 
the title  on each topic page. By default, the topic page shows the title with the same 
font and color as  decided on lesson master topic page. When you change the title 
settings, it asks whether to  apply the changes to all topic pages, only associated 
topic pages or only to new topic pages.  Selecting the required option applies the 
changes to all topic pages or to only associated topic  pages or only to new topic 
pages.  

 
9. Except title and background, no object on lesson master topic page can be edited, 

deleted,  moved or resized on the topic page. These objects can be edited only on 
lesson master topic  page.  

 
10. You can apply the layout of one lesson master to another lesson master by clicking on the  

'Apply Layout' icon on the toolbar. Clicking on this icon shows the list of lessons in the 

course.  Select the lesson of which you wish to apply the layout to the current lesson 

master topic page.  Clicking on OK applies the layout of master page of selected lesson to 

the current lesson.  

 

 

 

 



 

 

11. You can change the order of overlapping objects on the lesson master topic page by 
selecting  the object, right-clicking it and selecting the option 'Send to Back' or 'Bring 
to Front'. You can  also choose these options from Format-->Order menu.  

 
Notes:  
a. When you copy the topic page from one lesson and paste it in another lesson using the 
topic copy  option, the objects from the lesson master topic page are not copied.   
b. When you import a topic page, it gets imported without the objects from lesson master topic 

page.  

Creating Topic Pages 

 
For an overview of this topic, see About Topic Pages 
 
Topic pages that will contain the learning content can be created only after you have 
created its  lesson. That is, you have to create a lesson before you create topic pages. 
 
A topic page is created by specifying its title, and adding its content in a template. The 
template  could be the default template of Elicitus you have chosen for this course or it 
can be one of the 200+  readymade templates available (see Specifying Global 
Formatting for a Course). You can also  choose a new template for the topic page. 
 
Any template will provide, at specific locations, boxes of specific sizes for content such as 
topic title,  topic text, pictures and animation clips (Note: Some templates do not have 
boxes  for pictures or  animation clips). You can modify the template. For instance, you 
can add text  boxes, delete picture  boxes, or change the locations of animation boxes. 
 
You can enter the text directly in the text box or paste it from the clipboard from some 
other file. You  can also load an HTML page into a text box if the former does not have 
frames. Text can be  formatted in various ways. 
 
You can further enhance the learning experience as follows: 
 
• You can create hyperlinks in the text and attach it to media resources, web sites, 

or these  navigation commands: Previous Topic Page, Next Topic Page, and Go to 
(another topic  page).  

 
• You can insert pictures or flash animation clips in the topic page.  

 
• You can insert on pictures hot spots: transparent hyperlinks that are indicated to the 

learner by  change of the mouse pointer to the shape of a hand.  
 
• You can insert a wallpaper background to the topic page.  

 
• You can choose to play an audio or a video clip as soon as the learner opens the 

topic page.  This is known as adding auto audio and adding auto video.  

 
• You can insert buttons to your topic page and link the buttons to any media resource, i.e.  

picture, slide show, sound, HTML or text tile. You can also insert buttons with these 
navigation  commands: Previous Topic Page, Next Topic Page, and Go to (another topic 
page).  

 



The topic page you see while you do any of this is displayed to you as it will be 
displayed to the  learner. (You cannot change the learner's resolution. This has to be 
fixed before you create any  topic page of a course). 
 
Finally, you can add an exercise to the topic page. You can preview and print a topic page 
after you  have created it. 
 
NOTE: Any insertions you make in a topic page, or modifications to the template you 
make in a topic  page will apply to that topic page only. 
 
Topic pages of a lesson will be displayed to the learner in the order you have created 
them. You  can, however, change the position of topic pages in a lesson. 
 
You can modify or delete any topic page. 
 
To create a topic page: 
 
1. In the Course Explorer window, right-click the Lesson under which you want to create 

a Topic  Page, and from the pop-up menu click Add New Topic Page in this Lesson  
 

OR in the Course Explorer window, click the Lesson under which you want to create 
a Topic  Page, then in the main menu click Design, from the popup menu click Topic 
Page, and then  from the sub-menu click Add Topic Page.  

 
A dialog box confirming use of template displays.  

 
a. If you choose to option of using standard template with objects from lesson 

master topic  page, a topic page with standard template and all the objects from 
lesson master topic page  is created.  

 
b. If you choose the second option, you can choose from any of the 200+ standard 

templates  and a topic page with selected template along with objects from lesson 
master topic page is  created.  

 
c. If you choose to add a topic using the lesson master as template, a topic page with 

only  objects from lesson master is created. You can add new objects in actual topic 
design.  

 

d. The Topic Page is displayed on the right hand pane of the screen.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



2. Click Yes to use the default template. To change the template for a topic page click 
No, and  select a new template from a list that is displayed. This new template will 
apply only to this Topic  Page.  

 
The Topic Page is displayed on the right hand pane of the screen.  

 
Enter Title for the Topic.   
You may retain the global title font and title color settings or change them.  

 
To change the Title font and color:   
Click Title Font icon to select a new font. Click Title Color icon to select a 
new color.  The new font and color settings will apply only to this Topic 
Page.  
 

To align the title:  
Click the Align icon and select left, center or right from the sub menu. 

 
3. You may now:   

Modify the template  

 
Enter or paste text in the text box. Load a HTML page into the text box  

Create hyperlinks in the text and attach it to media resources. Create hyperlinks in 

the text to web sites  

 
Insert a picture or flash animation to the topic page.  Insert hot spots in pictures  

 
Insert a wallpaper background  

 

Choose to play an audio or a video file as soon as the learner opens the topic page  

 

Insert buttons to your topic page and link the buttons to any media resource, 
Previous Topic  Page, Next Topic Page, Go to (another topic page)  

 

4. On the Topic Toolbar click the Save Topic Page icon. You can now add a new topic 
page to the  lesson.  

Opening a Topic Page 

 
To open a topic page: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Topic Page.  

Modifying a Template 

 
You can modify a template in the following ways:  
• You can add title/ text/picture/animation boxes.   
• You can delete text/picture/animation boxes.   
• You can change the location or size of the title/ text/picture/animation boxes.  



 
To resize or change the position of a box on a topic page: 
 
1. On the Topic Page, click in the box. Blue squares are displayed around the borders of the 

box.  
 
2. Click an appropriate blue square and drag to resize or move the box.  
 
To add a box to a topic page:  
• In the Topic Page window, on the Control Toolbar, click the Add Text, Add 

Picture, Add  Animation or Add Title icon.  
 
 
 
 
 
Note: A topic page can have only one Title. 
 
To delete a box from a topic page:  
• Click in the box and on the Toolbar, click the Delete Control icon.   
• You can also delete a box from topic page by selecting it and hitting the Delete key of 

the  keyboard. For Text box and the title box, you need to click on the border of the 
box to select it for  deletion. On clicking, the border will change into a dotted border 
indicating  that it is selected and  can be deleted using the Delete key.   

• To move a box on a topic page: Click in the box and drag it to move to the desired 
location.   

• To cancel the previous action, click the Undo icon and to repeat the previous action, 
click the  Redo icon.  

Entering and Formatting Text in a Text Box 

 
Elicitus provides all standard options for formatting text in a text box in a topic page. For 
example,  you can make selected text bold, or you can align it left, or change its font or 
color, insert subscripts  and superscripts, etc. 
 
 
 
 
 
To enter and format text in a text box in a topic page: 
 
1. In the Topic Page window, click on a Text box in the Topic Page.The Text Formatting 

Toolbar is  displayed.  
 
2. Enter or copy paste text from the clipboard in the text box and format it using 

the Text  Formatting Toolbar as follows:  

 
To cut and move text to a clipboard, select the text and click the Cut icon.  To copy and 

move text to a clipboard, select the text and click the Copy icon.  

 
To paste clipboard text (cut or copied) at a desired location, click the cursor at the  
desired  location in the text, and then click the Paste icon.  

 

To make the text appear bold, select the text and then click the Bold icon.  To make 



the text appear as italics, select the text and then click the Italics icon.  To underline 

the text, select the text and then click the Underline icon.  

 
To left-align the text, select the text to be aligned and click the Align Left icon.  To right-

align the text, select the text to be aligned and click the Align Right icon.  To center-align 

the text, select the text to be aligned and click the Center icon.  To justify the text, select 

the text to be justified and click the Justify icon.  

 
To set the font and color for the text, select the text to be formatted. Click the Font 
and Color  icon to open a dialog box to select and confirm a font and a color. Click OK 
to confirm OR click Cancel to close the dialog box without changing the font and color.  
 

To create a numbered list, click the Numbering icon. To create a bulleted list, click the 

Bullet icon.  

 
To increase indenting of the text, select the text and click the Increase Indent icon.  To 

decrease indenting of the text, select the text and click the Decrease Indent icon.  

To make text appear as subscript select the text and click the Subscript icon.  

To  make the text appear as superscript, select the text and click the 

Superscript icon. 
 
3. To add scroll bar to the text box, click on Toggle Scrollbar.  
 
4. To add a term to the Glossary from the topic page, you need not go to the Glossary 

Builder You  can directly click on "Add to Glossary" icon from the text toolbar.  
 
5. To save this text formatting, on the Topic Toolbar, click the Save Topic Page icon  
 
 

Loading an HTML File into a Text Box 
 
 
 
 
 
To load an HTML file into a text box: 
 
1. In the Topic Page, click on a Text box of the Topic Page.The Text Formatting 

Toolbar is  displayed.  
 
2. On the Text Formatting Toolbar, click the Load Document icon.  
 
3. Click Browse to search for and select an existing .html or .htm file. Note that the 

hmtl/htm page  should not contain framesets.  
 
4. Click OK.  
 



Creating a Text File for Use as a Media Resource 
 
Elicitus gives you the facility to create a text file, which you can then use as a media 
resource. 
 
The text file can be created from the Media Resource Explorer window available while 
creating  Buttons, Hot Spots, Hyperlinks, and Questions and while inserting buttons/hot 
spots. 
 
The text file you create can then be attached as a Media Resource to any button, 
hot spot,  hyperlink, question or button/hot spot of the course. 
 

 
 

To create a text file for use as a Media Resource: 
 
1. In the Media Explorer window, click Create New Text File. This opens a text editor.  
 
2. Using the text editor, type the desired text.  
 
3. Click Save. Enter the name of the file in the text box for filename.  
 
4. Click OK.  

Creating Hyperlinks in a Topic Page 

 
You can create hyperlinks in the text to media resources, web sites, or these navigation 
commands:  Previous, Next, Go to Topic Page (another topic page) or Go to Assessment. 
 
 

 

 



 

 

To create a web hyperlink in a topic page to a website: 
 
1. In the Topic Page, click on the Text box in which you want to create the 

hyperlink.The Text  Formatting Toolbar is displayed.  
 
2. Select the text to be specified as a Web Hyperlink.  
 
3. On the Text Formatting Toolbar, click the Web Hyperlink icon. This formats the 

selected text  as a Web Hyperlink, and opens an input box.  
 
4. In this input box, enter the name and URL (site address; for example 

http://www.yahoo.com).  Note: The link will always be displayed in blue to the 
learner.  

 
 
To create a hyperlink in a topic page to media resources or navigation 

commands: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the Topic Page, click on the Text box in which you want to create the hyperlink. 
The Text  Formatting Toolbar is displayed. 
 
1. Select the text to be specified as a Hyperlink.  
 
2. On the Text Formatting Toolbar, click the Hyperlink icon. This formats the selected 

text as a  Hyperlink, and opens the Media Resource Explorer window.  
 
 
 
 
 



 
 
 
 
 
 
To link to a media resource: 
 

1.1. Click on its type (Picture, Slide Show, Sound, HTML File, Text File or Video Clip)  
 

1.2. To provide a link to other media resources such as WMV, PDF, WMP, XLS, CAD 
files, and  so on, click on type Other Resources.  

 
1.3. Search for the desired file by clicking the Browse button. To preview the selected 

file, click  Show Preview. However, you cannot preview the media resources 
attached using the  Other Resources link.  

 
1.4. Click the file and click OK.  

 
To link to a navigation command:  
 

Click Previous Topic Page, Next Topic Page, Go to Topic Page or Go to 
Assessment 
 
Note: You cannot choose Previous Topic Page option in the first topic of the first lesson 
and you  cannot choose Next Topic Page option in the last topic of the last lesson. 
 
When you click Go to Topic Page option, a hierarchy of Learning Units, Lessons and 
Topics  will be  displayed. Click the topic to which you want to direct the learner. 
 

Inserting a Hot Spot in a Topic Page 

 
You can insert hot spots or transparent hyperlinks of desired dimensions in a topic page 
and attach  them to media resources. For instance, you can have a hot spot over a 
picture with the text “Click on  picture to view explanation”. When the learner moves the 
mouse pointer over that picture the  pointer will change to the shape of a hand. When the 
learner clicks here, the attached file will open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To add a hot spot in topic page: 
 
1. In the Topic Page window, on the Topic Toolbar, click the Add Button icon. A dialog 

box for  creating a new button displays.  
 
2. Using the drawing editor, draw a hot spot of desired dimensions. You can 

specify the  dimensions in the Height and Width boxes.  
 
3. Click Settings. A Button Settings dialog box displays.  
 
4. Select Hot Spot.  
 
5. Drag and drop the hot spot to set its position on the topic page  
 
To attach a media resource to a hot spot: 
 
1. In the Topic Page window, right-click the  hot spot and, from the popup menu, click 

Settings. A  Button Settings dialog box displays.  
 
2. Click Button Object. This opens the Media Resource Explorer window.  
 
3. Search for the desired file by clicking the Browse button.  
 
4. To preview the selected file, click the Show Preview check box.  
 

5. Click the file and click OK.  

Inserting Images / Animation clips in a Topic Page 

 
 

 

 



 

You can insert image or animation clips in a Topic Page in boxes for this purpose. If the 

template  you have selected does not have these boxes, you can insert these boxes. The 

picture boxes are  clearly marked by ‘Double click here to add picture’ messages. (Note: 

The Elicitus image in the box  will not be displayed to the learner-- whether you chose to 

insert a picture or not). 

 
The picture you insert retains its original size in the picture box. If it is bigger than the 
frame it  appears clipped. If it is smaller than the frame it appears at the center. You can 
resize the picture to  fit the frame. 

 

You can insert buttons or hot spots on a picture box and link these to media resources or 
these  navigation commands: Previous Topic Page, Next Topic Page or Go to (another) 
Topic Page. On  clicking a button attached to a media resource, the chosen media 
resource file will display to the  learner. On clicking a navigation command button the 
learner will be taken to the specified topic  page. On clicking the hot spot, the chosen 
media resource file will display. 
 
To insert an image in a topic page: 
 
1. On the Topic Page, double click the ‘‘Double click here to add picture’. If the topic 

page does  not have a picture box with this message, click Add Picture on the topic 
toolbar.  

 
2. A Select Picture window displays. The left pane displays a list of available .bmp, .jpg, 

.wmf, .dib,   

.gif, .emf, or .ico picture files. The right pane displays a preview of the selected 

picture.  You can click Browse to search for a picture file.  
 
3. Click the picture file and click OK. The selected picture file is inserted in the picture 

box.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

To insert a flash animation movie in a topic page: 
 
1. On the Topic Page, click Add Flash Animation in the bottom right corner of the 

animation box.  If the topic page does not have an animation box with this icon, click 
Add Flash  Animation on  the topic toolbar, then click Add Flash Animation in the 
bottom right corner of the animation  box.  

 

2. A select Animation window displays. The left pane displays a list of available .swf  
animation  files. The right pane displays a preview of the selected animation.  

 
You can click Browse to search for an animation file. 

 
3. Click the file and click OK. It gets inserted in the animation box.  
 
4. If you wish to make the Flash Animation transparent, click Toggle Tranparency in the 

bottom  right corner of the animation box. Click it again if you want to make it 
opaque.  

 
 
 
 
 
 
 
 
 
 
 



 

 
 

 

To resize the picture to fit the frame: 
 
1. Right-click the picture frame. A shortcut menu displays. It contains a list of recently 

selected  pictures and the None, Button and Stretch Image options.  
 

2. On the shortcut menu, click the Stretch Image option. The picture will be resized to fit 
the frame  exactly. Note: If the size of the picture is not the same as the size of the 
picture box,  the picture  will be distorted.  



 
 
 
To insert a media resource or navigation command button or hot spot on a 

picture box: 
 
1. Right-click the box. A shortcut menu displays.  
 
2. On the shortcut menu, click the Button option. This inserts a button on the box 

exactly the size  of the box.  
 

Right-click the button and, from the popup menu,  click Settings. A Button Settings 
dialog  box displays.  

 
In the Button Settings dialog box, enter the Button Caption to tell the learner the 
function of  the button or hot spot.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
To insert a hot spot, select Hotspot 
 
To link button/hot spot  to a media resource: 
 
1. Click Button Object  
 
2. Click on media resource type (Picture, Slide Show, Sound, HTML File, Text File or Video 

Clip)  
 
3. To provide a link to other media resources such as WMV, PDF, WMP, XLS, CAD files, 

and so  on, click on type Other Resources.  
 
 



 
 
4. Search for the desired file by clicking the Browse button. To preview the selected file, 

click  Show Preview. However, you cannot preview the media resources attached 
using the Other  Resources link.  

 
5. Click the file and click OK.  

 
To link a button/hot spot to a navigation command:  
 

Click Previous Topic Page, Next Topic Page, Go to Topic Page or Go to Assessment.  

Note: You cannot choose Previous Topic Page option in the first topic of the first lesson  

and you  cannot choose Next Topic Page option in the last topic of the last lesson.  When 

you click Go to Topic Page option, a hierarchy of Learning Units, Lessons and  Topics will 

be displayed. Click the topic to which you want to direct the learner. 

 

Deleting an Image in a Topic Page 

 
When you delete an image in a topic page, its box will remain in the page. To delete the 
picture box  as well, see Modifying a Template 
 

To delete an image in a topic page: 
 
1. In the Topic Page, right-click in the picture. A shortcut menu displays.  
 
2. On the shortcut menu, click the None. An Elicitus image will be seen in the picture 

box. This  image will not be visible in the published Topic Page.  
 

Adding Auto Audio to a Topic Page 

 

To add auto audio to a topic page: 
 
1. In the Topic Page window, on the Topic Toolbar, click the Attach Media Resource icon.  
 
2. Click Auto Audio. This opens a Media Resource Explorer window.  
 
3. Search for the desired audio file ((.wav, .mid, .mp3, .ram or .rm) by clicking the 

Browse button.  To preview the selected audio file, click the Show Preview check box.  
 

4. Click the audio file and click OK. Selected audio will automatically play when the 
learner comes  to the topic page.  

 



 

Sound Recorder 

Elicitus provides a sound recorder which allows you to record narration for your content.  

To record narration, 

1. Open the Elicitus course  

2. Go to the Topic page  

3. Click on the Attach Media Resource button and it will open the Media Explorer.  

4. Click on the Sound recorder button at the bottom left corner of the screen and it 
will open the sound recorder for you  

5. Once the recorder is open, click on the Record button to start recording  

6. To pause the recording, click pause button  

7. Once you complete the recording, click Stop button and save the narration audio 
file at desired location. Note that the file is saved in .mp3 format  

8. Along with the location you choose, the file is also saved in the Waves folder of 
your course. You can immediately see the saved file in the list which you can use 
for your course.  

If you wish to use the same file for any other Elicitus course, simply browse for the 
location where you saved the file and select it. 



 

You will see following buttons on the Sound Recorder screen: 

Record: Clicking on this button starts the narration recording  
Pause: Clicking on this button pauses the recording  
Stop: Clicking on this button stops the recording  
Save: Clicking on this button provides you the option to save the file at the desired 
location  
Setting: Clicking on this button a dialog box will open where you can specify the audio 
related settings  
Help: Opens the help  
Cancel: Cancels the recording and closes the dialog box 

Adding Auto Video to a Topic Page 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To add audio video to a topic page: 
 
1. In the Topic Page window, on the Topic Toolbar, click the Attach Media Resource icon.  
 
2. Click Auto Video. This opens a Media Resource Explorer window.  
 
3. Search for the desired video file (.avi, .spl, .swf, .mpg or .mpeg) by clicking the 

Browse button.  To preview the selected video file, click the Show Preview check box.  
 
4. Click the video file and click OK. If the selected video file has a .avi, .mpeg or .mpg 

extension.  the mouse pointer will change into a box shape.  Move this pointer to 
where you want the video  to be played and click to set the video-play location. 
Selected video clip will automatically play  when the learner comes to the topic page.  

 

Inserting a Wallpaper Background to a Topic Page 

 
You can insert a color background to topic pages, or you can select one of your picture 
files and use  it as wallpaper. 
 
 
 
 
 
 
 
 
 



 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To insert a wallpaper background to a topic page: 
 
1. In the Topic Page window, on the Topic Toolbar, click the Attach Media Resource icon.  
 
2. Click Wallpaper. This opens a Select Wallpaper window which offers three options: 

Plain  color background as wallpaper, Picture background as wallpaper and No 
wallpaper.  

 
3. To select a Plain color wallpaper:   

In the Select Wallpaper window, click the Plain color background as wallpaper option. 
Click the  desired color in the color dialog box OR create a custom color by clicking 
the Define Custom  Colors button. The Preview pane shows you the selected color.  

 
4. To select a Picture as wallpaper:   

In the Select Wallpaper window, click the Picture background as wallpaper option. 
Search for  an appropriate image file (.bmp, .icon, .gif, .jpg, .dib or .emf) by clicking 
the Browse button. The  Preview pane shows you the selected image.  

 
5. Click OK.  
 

Deleting a Wallpaper Background to a Topic Page 
 
To remove a wallpaper background from a topic page: 
 
1. In the Topic Page window, on the Topic Toolbar, click the Attach Media Resource icon.  
 
2. Click Wallpaper. This opens the Select Wallpaper window.  
 
3. Click No wallpaper.  



Inserting Buttons in a Topic Page 

 
You can insert buttons of desired dimensions in a topic page and attach the buttons to 
media  resources or navigation commands. For instance, you can have a button that tells 
the learner “Click  here to view image”. On clicking the button the attached image will 
open. The message  “Click  here…” is called the button caption. It tells the learner the 
purpose of the button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To add a button to a topic page: 
 
1. In the Topic Page window, on the Topic Toolbar, click the Add Button icon. A dialog 

box for  creating a new button displays.  
 
2. Using the drawing editor, draw a button of desired dimensions. You can specify the 

dimensions  in the Height and Width boxes.  
 
3. Click Settings. A Button Settings dialog box displays.  
 
4. In the Button Settings dialog box, enter the Button Caption  
 
5. Click OK to close the drawing editor.  
 
6. Drag and drop the button to set its position on the Topic Page.  

 
To attach a media resource or navigation command to a button on a topic page: 
 
1. In the Topic Page window, right-click the button and, from the popup menu, click 

Settings. A  Button Settings dialog box displays.  
 
 



 
 
2. Click Button Object. This opens the Media Resource Explorer window.  To provide the 

link to button/hotspot, two options are availiable:  
 

Attach link to Media Resource: 

 
Click Button Object. This opens the Media Resource Explorer window. 

 

To link button/hot spot  to a media resource: 
 

1.1. Click on its type (Picture, Slide Show, Sound, HTML File, Text File or Video Clip)  
 

1.2. To provide a link to other media resources such as WMV, PDF, WMP, XLS, CAD 
files, and  so on, click on type Other Resources.  

 
1.3. Search for the desired file by clicking the Browse button. To preview the selected 

file, click  Show Preview. However, you cannot preview the media resources 
attached using the  Other Resources link.  

 
1.4. Click Window Properties button at the bottom right corner of the screen to 

decide the  window size for opening the media resource.  
 

1.5. Click the file and click OK.  
 

Attach link to Web Address: 
 

1.1. A text box to enter the Web address appears when you select this option.  
 

1.2. Type the required URL in the text box available.  

 

To link a button to a navigation command:  
 

Click Previous Topic Page, Next Topic Page, Go to Topic Page or Go to Assessment.  

Note: You cannot choose Previous Topic Page option in the first topic of the first lesson  

and you  cannot choose Next Topic Page option in the last topic of the last lesson.  When 

you click Go to Topic Page option, a hierarchy of Learning Units, Lessons and  Topics will 

be displayed. Click the topic to which you want to direct the learner. 

Deleting a Button or Hot Spot 

 
To delete a button or hot spot on a topic page:  
• In the Topic Page window, right-click the button to be deleted and, from the popup 

menu, click  Delete Button OR press the Delete key while the button is selected.  

Modifying a Topic Page 

 
To edit/modify a topic page: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Topic Page which is to be modified.  
 
 
 



 
 
4. The right hand pane will display the Topic Page in the edit mode.  
 
5. In the Topic Page window, make the desired changes to the Topic Page using 

the Topic  Toolbar and the Text Formatting Toolbar.  
 
6. On the Topic Toolbar, click the Save Topic Page icon.  

Deleting a Topic Page 

 

To delete a topic page: 
 
1. In the Course Explorer window, click the Topic Page which is to be deleted, then on 

the main  menu click Design. Then from the pop-up menu click Topic Page, and in 
the sub-menu click   
Delete Topic Page.  

 
OR In the Course Explorer window, right-click the Topic Page to be deleted and, from 
the pop  up menu, click Delete Topic Page.  

 
2. A message box confirming deletion is displayed.  
 
3. Click Yes to confirm OR click No to cancel the deletion.  

 
NOTE: When you delete a Topic Page the next topic opens in the right pane. If the 
deleted Topic is  the last one in the sequence the previous Topic opens in the right pane. 
 

Printing a Topic Page 

 
To print a current topic page: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Topic Page which is to be printed. Make the 

printer  ready.  
 
4. In the Topic Page window, on the Topic Toolbar, click the Print icon.  
 
 
 
 

  

Saving a Topic Page 

 
To save a current topic page:  
• In the Topic Page window, on the Topic Toolbar; click the Save Topic Page icon or 

click on the  Save link in File menu. This will save the current Topic Page with all its 
settings.  

 
 
 
 
 



 
 
 
 
 
 

Changing the Position of a Topic Page in a Lesson 

 
NOTE: You can change the position of a topic page only in its lesson. You cannot move 
the topic  page of one lesson to another lesson. 
 
To change the position of a topic page, you have to select it in the Course Explorer 
window and,  with the help of your mouse, place it on the position of the topic page 
before which you want it to  appear. For example, if you have four topic pages in a lesson 
and you and you want to place Topic  Page 4 after Topic Page 1 and before Topic Page 2, 
you should select Topic Page 4 and drag it and  drop it on Topic Page 2. 
 

To move the position of a topic page in a lesson: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click on the Topic Page to be repositioned, and drag 

and drop  the Topic Page to the desired position in the Lesson.  

Copying Objects on Topic Page 

 
You can copy the objects on topic page as picture, flash animation, button etc on the 
same topic  page or different topic page. 
 
To copy the object on a topic page: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
  
3. Open the topic page by clicking on it on the course explorer.  
 
4. Select the object you wish to copy by clicking on it. If you wish to copy multiple 

objects,  hold the  Shift key and select other objects.  
 
5. Once the selection of objects is complete, click Edit from the main menu and click 

Copy.  
 
6. To paste, click Edit from the main menu and click Paste. The copied objects will be 

pasted on  the topic page.  
 

7. If you want to paste the objects to a different topic page, go to the topic page you 

wish the  objects to paste to and click Edit from the main menu and click Paste to 

paste the objects.  

Format Objects on Topic Page 

 
 



 

 

To align the objects on topic page: 

 
1. Select the objects you want to align.  
 
2. To align the objects by their left, right, center, top, middle or bottom edges, click 

Format from  the main menu, click Align and then select the appropriate menu.  
 
To make the objects on topic page of same size: 

 
1. Select the objects you want to make of same size.  
 
2. Click Format from the main menu, click Make Same Size and then select the 

appropriate sub  menu to make the size same.  
 
To align the objects in the center of the page horizontally or vertically: 

 
1. Select the objects you want to align.  
 
2. Click Format from the main menu, click Center of Page and then select the 

appropriate sub  menu to make the size same. 
 

MANAGING EXERCISES 

Creating and Attaching Exercises to Topic Pages 

 
When you create an exercise in a topic page, it is automatically attached to that 

topic page.  You can insert questions in the exercise in two ways: 

• You can directly create questions, which become part of the exercise as well as the 
question  bank.   

• You can insert questions from the question bank.  

 
Questions are displayed in the order your insert them. You can however change the 
position of  questions in an exercise. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To create and attach an exercise to a topic page: 
 
In the Topic Page window, from the Topic Toolbar, click the Attach Exercise button OR 
 
in the Course Explorer window, right-click the Topic to which an Exercise is to be attached 
and, from  the pop-up menu, click Attach Exercise. 
 
An Exercise dialog displays. 
 
 
• Select the Automatically number the question option to automatically number the  

questions  and display those numbers.  

 
• Select the Show the question position within the exercise option to create a 

placeholder for  the question navigator (for example: question 1 of 10). The location, 
font and color of the  question navigator can be modified in the question layout editor.  

 

You may now:  
Create a Question  
Add Questions from the Question Bank 

 
To create a question: 
 
1. Click the Add Questions to Exercise icon. This opens an Add New Question interface in 

the  Question Bank Editor window.  
 
2. Create the Question and click Save. The newly created question gets added to the  

Exercise  and to the Question Bank.  
 
3. To customize the layout of the question, click Change Question Layout icon on the 

toolbar (See  also: Change Question Layout)  
 

 



 

 

To add questions from the question bank: 
 

• In the Exercise window, click the Add Questions from Question Bank icon. The 
Question  Bank Editor window displays.  

• Click question(s) to be added to the Exercise (click the column with checkbox). 
• Click the Add Selected Questions to Exercise icon. The question(s) gets added 

to the  Exercise. To cancel the selection of questions and return to the Exercise 
window, click the Back to Exercise icon.  

 
Add more questions to the exercise as above, then save and close the window. 

Creating Questions 

 
You can create questions from the Add New Question interface in exercises, assessments 
or the  Question Bank Editor. 
 
Questions can be of any one of these ten types:  
• Multiple choice   
• Fill in the blanks   
• True/False   
• Drag and drop   
• Match the pairs   
• Multiple correct answers   
• Visual identification   
• Multiple text entry   
• Graphic choice   
• Sequencing  
• Fill in the blanks with wildcard 

 
The procedure for creating each of these questions types is different, and is explained in 
separate  topics. 
 
In any question type, you can attach a media resource. For example, you can ask the 
learner to  read an attached text and answer your questions on it, or you can ask the 
learner to look at a picture  or hear a sound and answer your questions on it. 
 
In any question type you can choose to display a corrective message to the learner, 
which will be  displayed if the answer entered by the learner is wrong. You can also 
choose to display a  reinforcement text to the learner, which will be displayed if the 
answer entered by the learner is  correct. 
 
Note: In a match the pairs question the corrective message will be displayed even when 
a single  pair is matched incorrectly. The reinforcement text is shown when all the pairs 
are matched  correctly. 
 
You can give a hint and an additional hint to learners along with each or some questions. 
These  have to be in the form of media resources (Note: Media resource can also be a file with 
plain text). 
 
 
 
 
 



 
 
You can give scores for correct answers in each question type. These scores can be 
displayed to  the learner after the learner completes an assessment (Scores cannot be 
displayed after exercises  to a topic). 
 
Any question you create for any exercise or assessment is automatically added to the 
question  bank of the course 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To create a question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank 

Editor, click  the Add New Question icon. An Add Question dialog is displayed in 
which you can enter the  details of tex types of questions: Multiple Choice, Fill in the 
blanks, True/False, Match the  pairs, Multiple Correct Answers, Drag and drop, Visual 
Identification, Multiple Text  Entry, Sequencing and Graphic Choice.  
 
A Resource Toolbar is also available with five icons:  Attach Media Resource, Attach 
Hint, Attach Additional Hint, Save and Close.  

 
2. Click the Question Type and enter appropriate details. (See Creating a Multiple 

Choice  Question, Creating a Fill in the Blanks Question, Creating a True/False 
Question,Creating a  Match the Pairs Question, Creating a Multiple Correct Answers 
Question and Creating a  Graphic Choice Question).  



 

You may now: 
 

Attach a Media Resource to the question.  
Attach a Hint to the question.  
Attach an Additional Hint to the question.   
Enter Reinforcement Text. This can be 255 characters long.   
Enter a Corrective Message. This can be 255 characters long. 

 
To attach media resources, hints or additional hints to a question: 
 

On the Resource Toolbar click the Attach Media Resource icon, the Attach Hint icon or 
the Attach Additional Hint icon. This opens a Media Resource Explorer window.  
In the Media Resource Explorer window, click Media Resource (Picture, Slide 
Show, etc.)  and then search for the desired file by clicking the Browse button. 

 
To preview the selected file, click the Show Preview check box. 

 
Click the file and click OK. 

 
3. On the Resource Toolbar click Save. All information that was entered regarding 

the new question is saved.  
 
4. On the Resource Toolbar click Preview the Question. This shows the preview of the 

question.  You cannot preview the question unless all the required information is 
filled.  

 
5. On the Resource Toolbar click Close. This closes the Add Question dialog.  

Creating a Multiple Choice Question 

A multiple-choice question is created by specifying the correct answer and wrong answer 
choices or distracters to the text of the question. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 

 

 

 

 
 

 

 

 

 

 
 

 

 

 

 
 

 

 

 

 
 

 

 

 

To create a multiple choice question: 

 
1. In the Add Questions interface in exercises, assessments or the Question Bank 

Editor, click the Add New Question icon. An Add Question dialog is displayed in which 
you can enter the  details of ten types of questions  

 
2. In the Add Question dialog, in the Question text box, enter the text of the question.  
 
3. Under Question Type, select the Multiple Choice.  
 
4. In the Choices box, specify number of answer choices (maximum: 5).  
 
5. In the Score box, you may specify, in numbers, the maximum score for correctly 

answering the question (default score is 3).  
 
6. Under the Answers column, in the Correct Answer text box, enter the correct 

answer to the question.  
 
7. Under the Answers column, the dialog will display one less than the number 

entered in Choices, as the number of text boxes for the Distracters. Enter the 
false answers in the Distracters’ text boxes. You can provide a maximum of four 
distracters.  

 



Creating a Fill in the Blanks Question 

A fill in the blank question is created by specifying the text or numerical answer that has 

to be filled in the blank. The answer can be more than one word or numeral. For example 

it can be a phrase or a hyphenated number. If the learner can specify the answer in a 

different spelling (e.g., `color’; `colour’) or in alphabets or numbers (e.g. `four’; `4’), 

you should specify these alternatives also. 
 
To create a fill in the blanks question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank 

Editor, click the Add New Question icon. An Add Question dialog is displayed in which 
you can enter the  details of ten types of questions  

 
2. In the Add Question dialog, in the Question text box, enter the text of the question.  
 
3. Under Question Type, select the Fill in the blanks option.  
 
4. In the Score box, you may specify, in numbers, the maximum score for correctly 

answering the question (default score is 3).  
 
5. In the Answer text box, enter the correct answer to the question.  
 

NOTE: When more than one form of the correct answer is possible the correct answers 
should be entered by separating each variant of the answer by a semicolon 

 
(Color;Colour OR 4;Four) 

 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Creating a True/False Question 

 
To create a true/false question, you have to specify whether the text of the question is 
true or false. 
 
 
To create a true/false question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank 

Editor, click  the Add New Question icon. An Add Question dialog is displayed in 
which you can enter the  details of ten types of questions  

 
2. In the Add Question dialog, in the Question text box, enter the text of the question.  
 
3. Under Question Type, select the True/False option.  
 
4. In the Score box, you may specify, in numbers, the maximum score for correctly 

answering the  question (default score is 3).  
 

5. Under the Answers column, in the Correct Answer text box, select True or False.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Creating a Match the Pairs Question 

 
A Match the pairs question is created in two steps:  
• First, you have to specify all the entries in the right and left columns, as they should 

be  displayed to the learner. The number of entries in the right column should be 
greater than equal  to the entries in the left column.   

• You have to then specify which entries in the right column correctly match the entry 
in the left  column. One entry in the right column can correctly match only one entry 
in the left column. 



 
 
To create a match the pairs question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank 

Editor, click  the Add New Question icon. An Add Question dialog is displayed in 
which you can enter the  details of ten types of questions  

 
2. In the Add Question dialog, in the Question text box, enter the text of the question.  
 
3. Under Question Type, select the Match the pairs option.  
 
4. In the Score/Pair box, you may specify, in numbers, the maximum score for correctly 

matching  every correct pair (default score is 3).  
 
5. In the Pairs section, enter the options in the the right and left side text boxes. The 

number of  options in the right column should be greater than or equal to the number 
of options in the left  colum. Each option can be 60 characters long.  

 
6. Click the Answer Spec button. The text boxes in the right column will now appear as 

pull-down  list boxes. Clicking each list box displays all the options that you have 

earlier specified in the  right column. Select the correct option in each list box that 

matches the corresponding fixed  option in the left column. Repeat the operation until 

you specify correct answers for all the  options in the left column. To modify options 

in either column click Edit Pairs.  



Creating a Multiple Correct Answers Question 

 
The Multiple correct answers type of question allows having multiple answers as correct 

answers.  The published output displays a checkbox next to each of the choices given. 

The learner can select  the check box if he wants to opt for a particular choice. 



 
To create a Multiple correct answers type of question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank Editor,  

click  the Add New Question icon. An Add Question dialog is displayed in which you 

can enter the  details of ten types of questions.  
 
2. Select ‘Add Question’ from the Edit menu.  
 
3. Click on the Question Type dropdown menu and select the Multiple correct answers 

option.  
 
4. Type the Question text in the Question box.  
 
5. In the Choices box, specify number of answer choices (maximum: 5).  
 
6. Enter the Score/Answer. For Multiple correct answers type of question, the score is 

calculated  per correct answer.  
 
7. Type in the answer choices you want to give the learner. Select the check boxes next to 

only those choices that are correct. 
 

NOTE: 
On publishing the course, the score of the learner for the multiple correct answers type of 

question  is calculated only when the number of options selected by the learner are less 

than or equal to the  number of correct options. If the learner selects more options, then 

his score is not calculated for  that question. 

Creating a Graphic Choice Question 

 
The Graphic Choice type of question allows the choices to be in terms of graphics. This is 

similar to Multiple Choice type of question (with single correct answer). It allows the 

learner to select one graphic as an answer to the question. Instead of entering the text 

for the choices, you can browse the image to be added as a choice. The learner can select 

a single image as the correct answer. 



 
 

To add a Graphic Choice type of question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank Editor, 

click the Add New Question icon. An Add Question dialog is displayed in which you can 

enter the details of ten types of questions.  
 
2. Select ‘Add Question’ from the Edit menu.  
 
3. Click on the Question Type dropdown menu and select the Graphic choice option.  
 
4. Type the Question text in the question box.  
 
5. In the Choices box, specify number of answer choices (maximum: 5).  

 

6. In the Score box, you may specify, in numbers, the maximum score for correctly 

answering the question (default score is 3).  
 
7. Select the Correct Image from the ‘Browse’ button (button with 3 dots) in front of the 

Correct Answer box.  
 
8. Select the Distracter images from the ‘Browse’ buttons (buttons with 3 dots) next to 

the respective boxes.  



 

Creating a Drag and Drop Question 

 
A Drag and drop question is created by specifying the drop image, drag images, the 

positions of  drag images on the drop images to the text of the question. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To create a Drag and drop question: 

 
1. In the Add Questions interface in exercises, assessments or the Question Bank Editor, 

click the Add New Question icon. An Add Question dialog is displayed in which you can 

enter the details of ten types of questions.  
 
2. In the Add Question dialog, in the Question text box, enter the text of the question.  
 
3. Under Question Type, select the Drag and drop.  
 
4. In the Number of drag images box, specify number of drag image choices (maximum: 

5).  
 
5. In the Score/Answer box, you may specify, in numbers, the maximum score for 

correctly placing the drag image on the drop image (default score is 3).  
 



6. Select the drag images from the 'Browse' button (button with 3 dots) in front of the 

Drag images box.  

7. Select the drop image from the 'Browse' button (button with 3 dots) in front of the 

Drop image box.  
 
8. Enter the Reinforcement message which is shown when the learner placed all the drag 

images at the correct place.  
 
9. Enter the Corrective message which is shown when the learner places even a single 

drag image at incorrect position on the drop image.  
 
10. To specify the answer specification in terms of positions of drag images on the drop 

image, click 'Answer Spec'.  
 
11. Clicking on the Answer Spec button shows the 'Answer Specification Editor'. The 

‘Answer Specification Editor' shows the drag image and the drop images. Drag and 

place the drag images on the drop image for specifying the answer.  
 
12. To edit the question, click 'Edit Question' tab at the bottom of the screen.  
 

 

Notes: 
 
a. You can change the position and size of the question image here. Note that the 

question image is not stretched to fit in the box for the image. Therefore, if the image is 

of a larger size than the size of the box, it will get clipped and the smaller image will show 

blank area beyond its size.  
 
b. It is mandatory to place all the drag images within the boundaries of the drop image. 

Otherwise, the question cannot be saved.  

Creating a Multiple text entry Question 

 
A Multiple text entry question is created by specifying the text or numerical answers that 
has to be filled in the blanks. The answers can be more than one word or numeral. For 
example it can be a phrase or a hyphenated number. If the learner can specify the 
answer in a different spelling (e.g., `color'; `colour') or in alphabets or numbers (e.g. 
`four'; `4'), you should specify these alternatives also. 
 
The Multiple text entry question is similar to fill in the blanks question with multiple 
blanks. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
To create a Multiple text entry question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank Editor, 

click  the Add New Question icon. An Add Question dialog is displayed in which you 

can enter the  details of ten types of questions  
 
2. In the Add Question dialog, in the Question text box, enter the text of the question.  
 
3. Under Question Type, select the Multiple text entry.  
 
4. In the Number of blanks box, specify number of blanks in the question (maximum: 

5).  
 
5. In the Score/Answer box, you may specify, in numbers, the maximum score for 

correctly answering one blank of the question (default score is 3).  
 
6. Under the Answers column, enter the answers.  
 
7. Enter the Reinforcement message which is shown when the learner enters correct 

answer in all the blanks of the question.  
 
8. Enter the Corrective message which is shown when the learner answers even a single 

answer incorrectly.  

 



 

Creating a Sequencing Question 

 
A Sequencing question is created by specifying the choices to the text of the question. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To create a Sequencing question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank Editor, 

click the  Add New Question icon. An Add Question dialog is displayed in which you 

can enter the details  of ten types of questions  
 
2. In the Add Question dialog, in the Question text box, enter the text of the question.  
 
3. Under Question Type, select the Sequencing.  
 
4. In the Choices box, specify number of choices (maximum: 5).  
 
5. In the Score box, you may specify, in numbers, the maximum score for correctly 

arranging the sequence (default score is 3).  
 
6. Select   the   Choice   Alignment   as   Horizontal   or   Vertical.   The   choice   

alignment   option determines whether to place the choices horizontally or vertically.  

 
 



7. Under the Choices column, enter the choices which need to be sequenced. The 

sequence in which the choices are entered is considered as correct sequence. The 

sequence of the choices can be changed on the question layout editor when the 

question is added to assessment/ exercise.  
 

8. Enter the reinforcement message which is shown when the learner arranges the 

choices in the correct sequence.  
 
9. Enter the corrective message which is shown when the learner arranges the choices in 

incorrect sequence.  

Creating a Visual Identification Question 

 

A Visual identification question is created by specifying the question image, the position 
of correct hotspot and the positions of the distracter hotspots to the text of the question. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 



 

To create a Visual identification question: 
 
1. In the Add Questions interface in exercises, assessments or the Question Bank Editor, 

click the Add New Question icon. An Add Question dialog is displayed in which you can 

enter the  details of ten types of questions  
 
2. In the Add Question dialog, in the Question text box, enter the text of the question.  
 
3. Under Question Type, select the Visual identification.  
 
4. In the Choices box, specify number of answer choices (maximum: 25).  
 
5. In the Score box, you may specify, in numbers, the maximum score for correctly 

answering the question (default score is 3).  
 

6. Select the question image by clicking on the button in front of the question image 

box. This is the image where the correct and incorrect hotspots are to be placed.  
 
7. Enter the Reinforcement message which is shown when the learner gives correct 

answer.  
 
8. Depending on the number of choices you have selected in step # 4, the corrective 

messages can be specified. Select the corrective message # from the list box in front 

of corrective message. Enter the corrective message in the text box and click on 'Add' 

button. Similarly, select another corrective message and enter the message in the 

box. Corrective message is shown when the incorrect answer is selected.  
 
9. To specify the answer specification in terms of positions of correct and incorrect 

hotspots, click ‘Answer Spec'.  
 
10. Clicking on the Answer Spec button shows the 'Answer Specification Editor'. The 

‘Answer Specification Editor' shows the question image, the answer hotspot and 

distracter hotspots at the bottom of the screen. Drag the hotspots at the required 

locations on the question image for specifying the answer.  
 
11. To edit the question, click 'Edit Question' tab at the bottom of the screen.  
 
Notes:  
a. You cannot delete the hotspots on Answer Specification Editor. To change the number 
of hotspots, click 'Edit Question' tab at the bottom and change the number of choices. 
However, you can resize and move them and place at the required location.    
b. You can change the position and size of the question image here. Note that the question 

image is not stretched to fit in the box for the image. Therefore, if the image is of a larger size 

than the size of the box, it will get clipped and the smaller image will show blank area beyond 
it's size.  

 

c. It is mandatory to place all the correct and incorrect hotspots within the boundaries of   
the question image. Otherwise, the question cannot be saved. 



 

Changing the Position of Questions in an Exercise 

 
To change the position of a question in an exercise, you have to select it in 

Course Explorer window and, with the help of your mouse, place it on the position of the 
question before which you want it to appear. For example, if you have four questions in 
an exercise and you and you want to place Question 4 after Question 1 and before 
Question 2, you should select Question 4 and drag and drop  it on Question 2. 
 
To change the position of a question in an exercise: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Exercise that is to be modified. The Exercise 

window  displays  
 
4. In the Course Explorer window, click on the Question to be repositioned, and drag and 

drop it to the desired position.  

Deleting Questions from an Exercise 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 



 

 

To delete questions from the exercise:  
• In the Exercise window select the question(s) (click the column labeled ‘’) that you 

want to delete, and then click the Delete Questions from Exercise icon.  

Modifying an Exercise 

 
You can modify an exercise in any or all of these ways:  
• You can create (`add’) questions.   
• You can add questions from the question bank.   
• You can delete questions.  
 
You can also change the position of questions in an exercise. 
 
To create, add or delete questions in an exercise: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 

3. In the Course Explorer window, click the Exercise which is to be modified. The 
Exercise window displays the three icons: Add Questions to Exercise, Add Questions 
from Question Bank and Delete Questions from Exercise. Click on these options to 
create questions, add questions from the question bank and delete questions 
respectively.  

Deleting an Exercise 

 
To delete an exercise you have to delete all its questions.  To delete an exercise: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click the Exercise which in which the questions 

are to be deleted.  
 
4. In the Exercise window select (click the column with checkbox) all the questions in 

the Exercise, and then click the Delete Questions from Exercise icon. The entire 

Exercise will be deleted.  

Viewing an Exercise 

 
While viewing a published course, an exercise of a topic is displayed on clicking the 
Next Topic Page button in the topic page. 

 

Then the first question of the exercise will be displayed. Its hint and additional hint, if 

any, will be displayed when these buttons are clicked. After the answer of the question is 

entered, the corrective message will be displayed if the answer is wrong, and the 

reinforcement message will be displayed if the answer is correct, if you have chosen these 

options while creating the question. 

 



By default the screen has a Next button, to lead to the next question of the exercise. In 
this way all questions are displayed, one at a time. In the last question the Next button is 
disabled. 

 
At any stage while doing an exercise, the Quit exercise option can be used. In this case, 
the next topic page will be displayed. 
 

MANAGING QUESTION BANK 

Creating a Question Bank 

 
At any stage after you have created a new course record, you can create its question 
bank, containing questions that can be attached to any topic page of any lesson or any 
assessment of that course. You can modify or delete any questions in the question bank. 
 
To create a question bank: 
 
1. In the File menu click Open OR click the Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click Question Bank Editor. A Question Bank Editor 

window shows all existing questions in the Question Bank in the form of a list.  
 
4. Create a question.  
 
Add more questions as desired and close the Question Bank Editor.  Adding Questions to 

a Question Bank 

To add a question to a question bank: 
 
1. In the File menu click Open OR click the Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click Question Bank Editor. A Question Bank Editor 

window shows all existing questions in the Question Bank in the form of a list.  
 
4. Create a question.  
 
Add more questions as desired and close the Question Bank Editor. 

Modifying Question Bank 

 
You can modify a question bank in three ways:   

• You can modify a question 
• You can delete a question  
• You can add a question  

Modifying a Question in a Question Bank 

 
You can modify a question in the question bank following the procedure for creating a 
question. 
 



To modify a question in the question bank: 
 
1. In the File menu click Open OR click the Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click Question Bank Editor. A Question Bank Editor 

window shows all existing questions in the Question Bank in the form of a list. Click 
the question to be modified.  

 
A Question Bank Editor Toolbar is also available with three icons: Add New Question,   
Modify Question and Delete Question from Question bank.  

 
4. Click Modify Question. A Modify Question dialog is displayed in which you can 

modify the  details of the selected question  
 
Modify more questions as desired and close the Question Bank Editor. 

Deleting a Question from a Question Bank 

 
NOTE: When you delete a question in a question bank, it is automatically deleted from all 
exercises and assessments in which you have used it. 
 
To delete a question from the question bank: 
 
1. In the File menu click Open OR click the Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, click Question Bank Editor. A Question Bank Editor 

window shows all existing questions in the Question Bank in the form of a list. Click 

the question(s) (click the column labeled ‘’) to be deleted.  
 

A Question Bank Editor Toolbar is also available with three icons: Add New Question, 
Modify Question and Delete Question from Question bank.  

 

4. Click Delete Question from Question bank. The selected question(s) is deleted.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

MANAGING ASSESSMENTS 

Creating an Assessment 

 
At any stage after you have created a new course record, you can create an assessment 
for a learning unit or the entire course. The assessment will contain questions, which can 
be created and inserted directly or inserted from a previously created question bank. You 
can modify or delete any question. 
 
Elicitus can display to the learner at the end of the assessment the learner’s total score 
and maximum score for the assessment. Elicitus can also display the correct answers of 
all questions in the assessment. 
 
 

 

 

 

 

 

 

 

 

 



NOTE:  
• To display correct answers of questions and answer scores to learner, you have to 

choose these assessment settings.   
• Assessments will not be displayed if you or the learner has selected full screen 

(slide show) viewing format.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To create an assessment: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name. You may add a new Assessment directly under Course 

Contents OR add an Assessment to a Learning Unit in a Course.  
 
3. To add an assessment directly under course contents:   

In the Course Explorer window, right-click Course Contents, and click Add New 
Assessment from the popup menu OR From the main menu, click Design. From the 
popup menu click Assessment and from the sub-menu click Add Assessment.  

 
To add an assessment to a learning unit in a course:   
In the Course Explorer window, right-click Learning Unit, and then from the pop-up 
menu click Add New Assessment in this Learning Unit. A window for creating a new 
Assessment of the Course opens. 

 
4. In the window, enter Assessment Title. Title can be 100 characters long.  For example, you  

can name an Assessment according to the title of the Learning Unit or Course that it 
assesses.  



 
 
5. Enter Learning Objective to describe the scope of the Assessment.  
 
6. Enter Prerequisite to specify the knowledge the learner must have before 

doing this Assessment.  
 
7. Select the Show Pass/ Fail depending on the minimum passing score option to 

grade the  assessment as pass/fail based on the minimum passing score and specify 
the percentage in  the box based on which the pass/fail grade is to be determined.  

 
8. Select the Automatically number the question option to automatically number 

the questions and display those numbers.  
 
9. Select the Show the question position within the assessment option to create a   

placeholder for the question navigator (for example: question 1 of 10). The position, 
font and color of the question navigator can be modified in the question layout 
editor.  

 
10. Select the Randomize the questions option to randomize the questions in the 

assessment so that every time the learner attempts the assessment, he sees the 
questions in a different sequence.  

 
11. Select the option Show a Set of Questions if you want to show a subset of questions 

in the assessment to the learner. Selecting this option chooses the set number of 
questions from the total questions in the assessment and shows those to the learner.  

 
12. Click Save. The information provided is saved and the Assessment dialog will close. A 

dialog for adding questions to this Assessment is displayed with three icons on the 
toolbar.  

 
13. To create a new question and insert it in the assessment:   

Click the Add Questions to Assessment icon. This opens an Add New Question 
interface in the Question Bank Editor window. Create the question and click Save. The 
Question gets added to the Assessment and to the Question Bank.  

 
 
To add questions from the question bank to the assessment: 

Click the Add Questions from Question Bank icon. In the Question Bank Editor 
window, from the list of questions displayed, click questions to be added to 
the Assessment by clicking the column with checkbox. You may now add the 
selected questions or cancel the selection and return to the Assessment 
window. 

 
To add the selected questions to the Assessment and return to the Assessment window:   

Click the Add Selected Questions to Assessment icon 
 
To cancel the selection of questions and return to the Assessment window:   

 
Click the Back to Assessment icon. 

Adding Questions to an Assessment 

 
• You can add questions to an assessment in two ways:   
• You can create questions and insert it in the assessment  
 

You can add questions from the question bank 

 



To add questions to an assessment:  Open the assessment 
 
To create a new question and insert it in the assessment: 

Click the Add Questions to Assessment icon. This opens an Add New Question 
interface in the Question Bank Editor window. Create the question and click Save. The 
Question gets added to the Assessment and to the Question Bank. 

 
To add questions from the question bank to the assessment: 

Click the Add Questions from Question Bank icon. In the Question Bank Editor window, 
from the list of questions displayed, click questions to be added to the Assessment by clicking 
the column with checkbox.  You may now add the selected questions or cancel the selection 
and return to the Assessment window. 
 
. 
To add the selected questions to the Assessment and return to the Assessment 

window:   
Click the Add Selected Questions to Assessment icon 

 
To cancel the selection of questions and return to the Assessment window:   

Click the Back to Assessment icon 

Deleting Questions from an Assessment 

 
To delete questions from an assessment: 
 
1. Open the assessment.  
 
2. In the Question Bank Editor window, select the questions (click the column labeled ‘’) 

that you want to delete from the Assessment. Click the Delete Questions from 

Assessment icon.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

Opening an Assessment 

 
To open an assessment: 
 
1.   In the File menu click Open OR Click Open Course icon on the toolbar. 

  
2. Click course file name.  
 
3. In the Course Explorer window, click the Assessment to be opened.  

Modifying an Assessment 

 
You can modify an assessment in any or all of these ways:  
• You can add questions   
• You can delete questions   
• You can change the position of questions   
• You can attach an assessment to a different learning unit  
 
 
 
 
 
 



 
To modify the assessment details or attach an assessment to a different learning unit: 
 
1. In the main menu click Design, then click Modify Assessment in the pop-up menu. 

The right  pane will display the Assessment in the edit mode.  
 
2. Make the desired changes to Assessment Title, Learning Objective or Prerequisite. 

To  attach assessment to a different learning unit, In the Course Explorer window, 
right-click   
Learning Unit, and then from the pop-up menu click Add New Assessment in this 
Learning  Unit  

 
3. Click Save.  
 

Changing the Position of Questions in an Assessment 

 
To change the position of a question in an assessment, you have to select it and, with 
the help of  your mouse, place it on the position of the question before which you want it 
to appear. For  example, if you have four questions in an assessment and you and you 
want to place Question 4  after Question 1 and before Question 2, you should select 
Question 4 and drag and drop it on  Question 2. 
 
To change the position of a question in an assessment: 
 
1. In the File menu click Open OR Click Open Course icon on the toolbar.   
2. Click course file name.   
3. In the Course Explorer window, click the Assessment to be opened.   
4. Click on the Question to be repositioned, and drag and drop it to the desired position.  

Deleting an Assessment 

 
To delete an assessment: 

 
1. In the File menu click Open OR Click Open Course icon on the toolbar.  
 
2. Click course file name.  
 
3. In the Course Explorer window, right-click the Assessment to be deleted and, from 

the pop-up  menu, click Delete Assessment.  
 

OR  
 

In the Course Explorer window, click the Assessment which is to be deleted. In the main 
menu,  click Design. Then from the pop-up menu click Assessment and, from the sub-
menu  click   
Delete Assessment.  

 
A message box confirming deletion is displayed.  

 
4. Click Yes to confirm OR click No to cancel the deletion.  
 
 
 
 
 
 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

 

 

 

Viewing an Assessment 

 
An assessment of a learning unit or course is displayed to the learner on clicking Click 
here to view  the assessment link in the course outline screen. (NOTE: Assessments will 
not be displayed if you  have chosen full screen (slide show) format as your output 
setting). 
 
Then the first question is displayed. Its hint and additional hint, if any, will be displayed when  

these buttons are clicked. By default the screen has a Next button, to lead to the next 

question. In  this way all questions are displayed, one at a time. In the last question the Next 

button is disabled. 
 
At any stage while doing an assessment, the Quit option can be used to quit from the 
assessment. 
 
After the answers of all questions are entered, the corrective messages for wrong 
answers and  the reinforcement messages for right answers will be displayed in the 
Display Answers Page, if  you have chosen these options in Course Preferences while 
creating the course. 
 
 



 
If you have chosen to display scores after assessment, then total scores earned will be 
displayed at  the end of the assessment along with the maximum total scores. These will 
be displayed as Your  Score and Maximum Score respectively. 
 

Modifying Question Layout 

 
Elicitus allows you to modify the layout of the questions in assessments and exercises. 
 
You can modify a question layout in the following ways: 
 

• You can add title/ text/picture/animation boxes.   
• You can delete text/picture/animation boxes.   
• You can change the location or size of the title/ text/picture/animation boxes.   
• You can change the location or size of the question information like question text, 

choices.  
 
To modify the layout of the questions: 
 
1. On the question editor, click the Change Question Layout icon on the toolbar to open 

the  Question Layout Editor page.  
 
2. Click the relevant icon from the following:   

• Attach Wallpaper: To attach wallpaper (plain color or image) to the question.   
i. Click the Attach Wallpaper icon and select any one of the following options: 

Plain  color background as wallpaper, Picture background as wallpaper, 
and No  wallpaper.   

ii. For plain color background, either select the desired color in the dialog box 
or  preview and create a color by clicking the Define Custom Colors button.   

iii. For a picture background, search for an appropriate image file (.bmp, ico, .gif, 
.jpg,   
.dib or .emf) by clicking the Browse button.   

iv. Click OK.  

 
• Apply Layout: To apply the layout of another question of the same type. (See 

Apply  Layout)  
 

• Preview: To preview the question.  

 

• Add Reinforcement Placeholder: To provide placeholder for the reinforcement 
when the  learner has provided correct answer to a question. Only one placeholder 
is allowed per  question.  

 
• Add Corrective Message Placeholder: To provide placeholder for corrective 

messages.  Only one placeholder is allowed per question.  
 

• Add Text: To add a text box, on the Question Editor Toolbar, click the Add Text 
icon.  

 
• Add Picture: To add a picture, on the Question Editor Toolbar, click the Add Picture 

icon.  
 
 



 

• Add Flash Animation: To add Flash animation, on the Question Editor Toolbar, 
click the  Add Flash Animation icon.  

 
• Delete  Control: To delete the selected  object. Question text and choices cannot 

be  deleted.  
 

• Cancel Selection: To cancel the selection.  
 

• Set Attributes: To set the left, top, height and width attributes of the selected 
object.  

 
• Change Font: To change the font of the selected object text.  

 
• Change Font Color: To change the font color of the selected object text.  

 
• Save: To save the question layout.  

 
• Help: To display online help.  

 
• Edit Question: To go back to the question input form and edit the question 

information.  
 

Notes: 
 
Submit Button: 

 
a. A Submit button is provided for all questions in the assessment. The Submit button 

does not  appear for the exercises as exercises show the immediate feedback to the 
learner.  You cannot delete the Submit button. However, you can change the images 
and the tool tip for  the button.  

 
b. To change the images/tool tip for the Submit button:   

1. Double-click the Submit button. The Submit Button Settings dialog box is 
displayed.  

 

2. Type the tool tip text for the Submit button in the box provided.  

 
3. Select an image/MouseOverImage for the Submit button by clicking on the 

Select  button provided.  
 

4. Click the Load Default button to use default images for the Submit button.  
 

5. Click the OK button to apply the changes.  

 
c. The Submit button appears when the learner has reached the last question and allows 

the  learner to submit the assessment.  

 
d. Thereafter, the Submit button appears for all questions and enables the learner to 

submit the  assessment at any stage.  
 
 

 

 



Done Button: 
 
a. A Done button is provided for the questions of types Match the pairs and Multiple 

correct  answers when the questions of these type are added in the exercises. Clicking 
on the done  button will show the immediate feedback to the learner. On completing 
the selection, the  learner would need to click on Done button to see the feedback.  

 
You cannot delete the Done button. However, you can change the images and the tool 
tip for  the button.  

 
b. To change the images/tool tip for the Done button:   

1. Double-click the Done button. The Done Button Settings dialog box is 
displayed.  

 
2. Type the tool tip text for the Done button in the box provided.  

 
3. Select an image/MouseOverImage for the Done button by clicking on the 

Select button  provided.  
 

4. Click the Load Default button to use default images for the Done button.  
 

5. Click the OK button to apply the changes.  
 

Apply Layout 
 
Elicitus allows you to apply the layout of an existing question to another question that is 
either  already existing or is being created. Both questions must be of the same type. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

To apply the layout of an existing question to another question of the same type: 
 
1. Either click Open in the File menu or click the Open Course icon on the toolbar.  
 
2. Click the course file name.  

 
3. Either create a new question and add it to the assessment or modify a question 

already added  to the assessment and click the Save button.  

 

4. On the Question Bank Editor page, click the Apply Layout icon on the Question Editor 
Toolbar  to open the Apply Layout dialogue. This page displays a list of all questions of 
the same type  and the same number of choices in all the course assessments and 
exercises whose layout can  be applied to the new question.  

 
5. Select an appropriate question from the list.  
 
6. Click the Show Preview button to preview the selected question.  
 
7. Click the OK button to apply the settings of the selected question to the question.  

 
You can also apply the layout of Score page in one assessment to the score page in 
another  assessment. 
 
To apply the layout of an existing score page to score page in another assessment: 
 
1. Either click Open in the File menu or click the Open Course icon on the toolbar.  
 
2. Click the course file name.  

 
3. On the Score Page Editor page, click the Apply Layout icon on the Control Toolbar to 

open the  Apply Layout dialogue. This page displays a list of all existing score pages.  
 
4. Select an appropriate score page from the list.  
 
5. Click the Show Preview button to preview the selected score page.  
 
Click the OK button to apply the layout of the selected score page to the score page 

Modifying Assessment Score Page 

 
Elicitus enables the author to customize an assessment score page. 
 
To customize an assessment score page: 
 
1. Click the Score Page link for the assessment in the Course Explorer window. This 

displays the  Score Page Editor page in the right pane.  
 
 
 
 
 
 
 
 



 
2. Click the relevant icon from the following:   

• Attach Wallpaper: To attach wallpaper (plain color or image) to the score page.   
i. Click the Attach Wallpaper icon and select any one of the following 

options:   
Plain color background as wallpaper, Picture background as wallpaper,  
and No wallpaper.   

ii. For plain color background, either select the desired color in the dialog 
box or  preview and create a color by clicking the Define Custom Colors 
button.   

iii. For a picture background, search for an appropriate image file (.bmp, .icon, 
.gif,   
.jpg, .dib or .emf) by clicking the Browse button.   

iv. Click OK.  

 
• Apply Layout of another Score Page: To apply the layout of another already 

existing  score page. (See Apply Layout)  
 

• Preview: To preview the score page.  
 

• Add Date: To provide a placeholder for date.  

 
• Add Assessment Title Placeholder: To provide a placeholder for the assessment 

title.  The assessment title gets inserted automatically.  

 
• Add Score Placeholder: To provide a placeholder for the score. The score is 

calculated  after the learner has taken the assessment and is  displayed at the  
position  of the  placeholder.  

 
• Add Result Placeholder: To provide a placeholder to display the percentage.  

 
• Add Text: To add a text box, on the Question Editor Toolbar, click the Add Text 

icon.  

 
• Add Picture: To add a picture, on the Question Editor Toolbar, click the Add 

Picture  icon.  
 

• Add Flash Animation: To add Flash animation, on the Question Editor Toolbar, click 
the   
Add Flash Animation icon.  

 

• Add Name Placeholder: To provide a placeholder for the learner to add his/her 
name,  which can be displayed on the print-out of the score page.  

 
• Add Organization Placeholder: To provide a placeholder for the learner to add 

his/her  organization name, which can be displayed on the print-out of the score 
page.  

 
• Add E-mail Placeholder: To provide a placeholder for the learner to add his/her 

e-mail  address, which can be displayed on the printout of the score page.  
 

• Add Print Button: To add a print button. The images of the print button can be 
changed.  

 
 



 

 

• Delete Control: To delete the selected object.  
 

• Cancel Selection: To cancel the selection.  
 

• Set Attributes: To set the left, top, height and width attributes of the selected 
object.  

 
• Change Font: To change the font of the selected object text.  

 
• Change Font Color: To change the color of the selected object text.  

 
• Save: To save the score page layout.  

 
• Help: To display online help.  

 
 
Note: The OK and the Cancel buttons cannot be deleted. However, you can change the 
images for  the following buttons: OK, Cancel, and Print. 
 
To change the images for the OK/ Print buttons: 
 

1. Double-click any of the OK/ Print buttons for which the image has to be 
changed. The   
OK/ Print Button Settings dialog box is displayed.  

 
2. Select an image/MouseOverImage for the button by clicking on the Select 

button  provided.  

 
3. Click the Load Default button to use default images for the button. Click on the 

OK  button to apply the changes.  
 

MANAGING GLOSSARY 

Opening the Glossary Builder 

 
To open the Glossary Builder for a course: 
 
1. In the File menu click Open OR click the Open Course icon on the toolbar.  
 
2. Click course file name  
 
3. In the Course Explorer window, click the Glossary Builder option  

 
OR In the main menu click Tools, then from the popup menu click Glossary 
Builder  OR On the toolbar, click the Glossary Builder icon. 

Creating A Glossary 

 
To create a glossary you have to enter glossary terms and their descriptions.  Each term 
should  have a description. The description in text format can be elaborated with the help 



of a media  resource. 
 
Glossary terms can be associated with categories of your choice. For example in a 
course on  Music, you may have categories such as Musical Terms, Instruments, Music 
History, etc. If you  wish to associate terms with categories, you have to create the 
categories before you enter the  terms. One term can be linked to more than one 
category. 
 
You can modify/delete glossary terms and categories 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

To create a glossary: 
 
1. Open the Glossary Builder  
 

If you wish to create glossary categories:   
1.1. Click Add Category.  A new category dialog box opens.  

 
1.2. Enter category name.  

 
1.3. Click OK.  

 
 
 
 
 
 
 



 
1.4. Enter more categories by repeating the above steps.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click Add Glossary Term icon in the Terms column. The New Term dialog box displays.  
 
3. Enter your first glossary term in the Enter Glossary Term box.  
 
4. Enter description of the term in Enter Description box.  

To attach a media resource to the description:  
 

1.1. Click Media Resource.  The Media Resource Explorer dialog box opens.  
 

1.2. Click the appropriate media resource type. A list of files associated with that 
media  resource display on the right hand side of the dialog box.  

  
1.3. Click the file and click OK. 

 
If you created glossary categories (see step 1 above) select the category or 
categories for the  terms. 
 
5. Click Save.  
 
6. Click Close.  
 
7. Enter more glossary terms repeating steps 2 to 6.  

Modifying a Glossary Term 

 
To modify a glossary term: 
 
1. Open the Glossary Builder.  
 
2. In the Glossary Builder window, in the Terms column, click the term to be modified. (If the 

list is  long and you know how the the term has been spelt, you can search for the glossary 
term).  

 
3. Right-click the selected term and click Modify Term OR on the toolbar, click the Modify 

Term  icon. Make the desired changes to the term.  
 
4. Click Save.  
 
5. Click Close.  
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 
 

Deleting a Glossary Term 

 
To delete a glossary term: 
 

 
 
 
 
 
1. Open the Glossary Builder.  
 
2. In the Glossary Builder window, in the Terms column, click the term to be deleted. (If the 

list is  long and you know how the the term has been spelt, you can search for the 
glossary term).  

 
3. Right-click the selected term and click Delete Term OR on the toolbar, click the 

Delete Term  icon.  
 

A message box confirming the deletion is displayed.  
 
4. Click Yes to delete the term OR click No to cancel deletion and close the message box.  



 

Deleting a Glossary Term Category 

 
To delete a glossary term category: 
 
1. Open the Glossary Builder  
 
 
2. In the Glossary Builder window, in the Categories column, click the category to be 

deleted.  
 
3. Right-click the selected category and click Delete Category OR on the toolbar, click 

the Delete  Category icon.  
 
 
 
 
 
 
 
 

A message box confirming the deletion is displayed. 
 
4.   Click Yes to delete the category OR click No to cancel deletion and close the message 
box. 

Modifying a Glossary Term Category 

 
To modify a glossary term category: 
 
1. Open the Glossary Builder.  
 
2. In the Glossary Builder window, in the Categories column, click the category to be 

modified.  
 
3. Right-click the selected category and click Modify Category OR on the toolbar, click 

the   
Modify Category icon.  

 
4. Make the desired changes to the category.  
 
5. Click OK.  
 
 
 
 
 
 
 
 

Viewing Glossary Terms 

 

 

 

 

 

 



 
You can view glossary terms in any of the following ways: 

  
• You can view all glossary terms   
• You can view glossary terms alphabetically   
• You can view glossary terms by categories, if you have created categories  
 
To view glossary terms:  
• Open the Glossary Builder. The Glossary Builder window is opens, showing the 

Terms,  Description and Categories columns.  
 
 

By default view all glossary terms are displayed in an alphabetical order. To switch 
back from  other viewing options to this default view, on the toolbar, click the All 
Terms icon.  

 
 
 
 
 
 
 

A list of alphabets is displayed on the right of the Glossary Builder window. To view all 
Glossary  Terms starting from a particular alphabet, click the alphabet. 

 
To view glossary terms by a particular category, in the Categories column, click the 
desired  category. The Glossary Terms from that category will be displayed under 
the Terms column. 

Searching for a Glossary Term 

 
To search for a glossary term:  
1. Open the Glossary Builder  
 
2. On the lower side of the Glossary Builder window, in the Search for box, enter the 

glossary  term.  
 

3. Click Go. The Term along with its Description and the Categories displays. 
 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

IMPORTING FROM A COURSE 

Importing Learning Objects 

 
For an overview of this topic, see About Import 
 
Importing a course or part of a course: 
 

• Select File menu > Import and then select the course from which you want to 
import the  learning objects.   

• Once you select the course, it is checked for validity and if it is a valid course, the 
complete  hierarchy of the selected course is shown in tree format. The tree 
structure has check  boxes to allow the selection of learning objects.  

 
• You can decide the rule of import using the Import Settings. These settings are 

applied to  the course in which the learning objects are getting imported.  
 

• Once the import is complete, you can view the Import log by clicking the View 
Import Log  button. The log describes the actions performed during the learning 
objects import.  

 
 

 



NOTES: 
 

- If the selected course has a different output window size setting, then the lessons 
and topic  pages in that course cannot be imported.   

- If the selected course is created in an older version of Elicitus, then the import is 
not  allowed.   

- The selected course cannot be the same as the already open course.   
- If the course you want to import is on the network and has a Read-Only 

permission, it  cannot be imported. Also, if you are importing the course from the 
network, make sure to  map the drive. Selecting the course directly from the 
network path without mapping may not  import the learning objects properly.   

- Make sure that the course you select for import is not open for editing while it is 
being  imported.  

Rules for selecting learning objects from a course 

 
Depending on your selection of the learning objects, different rules are applied for 
import of the  objects. 
 
1.   Selection: Course Node 
 
- If you select (check the check box of) the course i.e. the first node of the tree, all the 

sub items  under the course are selected.   
- Selecting the complete course for import, imports all the learning objects in the 

course. The  import settings are applied during import.  
 
2.   Selection: Learning Unit 
 
- If you select the learning unit, all the sub-items (lessons, assessments, and topic 

pages) under  that Learning Unit are selected for import.   
- You can, however, de-select the unwanted items from the selection.   
- For  example,  if  the  learning  unit  contains  Lesson1,  Lesson2  and  Assessment1,  

you  can  de-select Lesson1 from the import so that the learning unit gets imported 
only with Lesson2 and  Assessment1.  

- If you de-select all the sub-items (lessons, assessments) under the learning unit, it 
imports the  learning unit by applying the rule for learning unit import.  

 
NOTE: If the import setting for learning unit is “Do not import,” then the lessons 
grouped under  that learning unit are not imported.  

 
3.   Selection: Lesson 
 
- If you select the lesson, all the topic pages under that lesson are selected.   
- You can, however, de-select the unwanted items from the selection.   

For example, if the lesson contains Topic1, Topic2 and Topic3, you can de-select 
Topic2 from  the import so that the lesson gets imported only with Topic1 and Topic3.   

- If you de-select all the sub-items (Topic pages) under the lesson, it imports the 
lesson by  applying the rule for lesson import.  

 
 

 

 
 

 



 

NOTES:  

 

- If an assessment with the same name as that of lesson already exists in the 
course, the  Lesson is not imported.   

- If the import setting is “Do not import,” then the topics under that lesson are not 
imported.  

 
4.  Selection: Topic Page 

-    If you select the topic page, the lesson under which it is grouped is also selected. You 
cannot import the topic page individually. You have to import it with the lesson to which it 
belongs. 
 
NOTES: 

 
- The import settings for the topic page import are applied only when the topic 

page is  imported within the existing lesson in the course.   
- The links to the topic pages (provided using button/hotspot, hyperlinks) may not 

be retained  after the import into the target course.   
- You can preview the Topic page by clicking the Preview button or by right clicking 

the topic  page and selecting the Preview Topic Page option. The toolbar of the 
target course i.e. the  course in which you are importing the learning objects will 

be shown for the topic page.  
 

6. Selection: Assessment  
 

- If you select the assessment, all the questions under that assessment are 
selected.   

- You can, however, de-select the unwanted questions from the selection.   
- If  you  de-select  all  the  sub-items  (questions)  under  the  assessment,  it  

imports  the  assessment by applying the rule for assessment import.   
- When you import an assessment, all the questions in the assessment are 

imported into the  Question Bank.   
- The import settings for the questions are applied during the question import.  
 

NOTES: 
 

- When the import setting for the question is set to “Do not import,” or when the 

question has  the same text as that of an already existing question, the question is not 

imported. In such  case, the assessment points to the existing question in the course. 

In some cases, if the  question already existing in the course is of a different type, it is 

linked to the assessment.   
- If a lesson with the same name as that of an assessment already exists in the 

course, the  assessment is not imported.   
- If the import setting for an assessment is “Do not import,” then the 

questions in that  assessment are also not imported in the Question Bank.   
- You can preview the question in the assessment by clicking the Preview button 

or right  clicking the question and selecting the Preview Question option.  
 
 
 
 
 



 
7. Selection: Question Bank  

 
- If you select the Question Bank all the questions in the Question Bank are selected.   
- You can then de-select the unwanted questions from the selection.  
- If you de-select all the questions under the Question Bank, it also de-selects the 

selection of the  Question Bank.   
- The import is done according to the Settings done through Import Settings.  
 
NOTE:  
- You can preview questions in the Question Bank by clicking the Preview button or 

right clicking  the Question and selecting the Preview Question option.  
 
7.   Selection: Glossary 
 
- If you select the Glossary all the Terms and Categories in the Glossary are selected.   
- You can, however, de-select the unwanted Terms or Categories from the selection.   
- Importing the Term imports all the Categories associated with the Term.   
- You can either import both the Terms and Categories together, or only the Terms or 

only  Categories.   
- If  you de-select  all the Terms and Categories under the Glossary,  it also de-selects 

the  selection of the Glossary.   
- The import is done according to the Settings done through Import Settings.  
 
8.   Selection: Score Page 
 
- If you select the score page, the assessment under which it is grouped is also 

selected. You  cannot import the score page individually.  
 
NOTE: 
 
- You can preview score page by clicking the Preview button or right clicking the score 

page and  selecting the Preview option.  
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Import Settings 

 
The Import Settings allow you to set the default action to be performed in case 
learning object  with the same title already exists in the target course i.e. the course 
in which you are importing  the learning objects. 

 
a. Replace entire <>:  

 

Choosing this option replaces the existing object completely. Thus, all the sub-
items in the  existing learning objects are lost and are replaced with the new 
items.  
 
 
 
 



 
 

b. Create copy:  

 

Choosing this option creates a copy of the selected object with the title as <Copy 
1 of> …,  <Copy 2 of> ….  

 

c. Do not import:  
 

Choosing this option does not import the duplicate Learning Objects.  
 

d. Import in existing <>:  

 

Choosing this option imports the learning objects into the existing learning object.  
For example, the Learning Unit 1 in the target course contains Lesson1 and 
Lesson2 and  you try to import a Learning Unit with the same title from the 
source course containing  Lesson3 and Lesson4. On import, the target Learning 
Unit 1 contains Lesson1,  Lesson2,  Lesson3 and Lesson4. 

 
e. Allow duplicate:  

 

Choosing this option imports the duplicate learning objects. This option is available 
only for  topic pages and questions.  

 

f. Ask me before overwrite:  

 
This option is available only for Media Resources. If you chose this option, it will ask 
before  overwriting each media resource during import. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Export course to XML: 

 

Elicitus allows you to export the complete course structure to .xml file. The XML file 
defines the course hierarchy and also provides the relevant and important useful 
information about the learning objects in the course. 
To export the course to .xml file,  

1. Click on menu File-->Export to XML.  

2. Clicking on the menu opens a dialogue where you need to select the .xml file to 
which you want to export the course.  

3. Note that you always have the option to export the Question Bank or Glossary, 
which is optional. The export of Question Bank and Glossary depends upon the 
author.  

4. Select the .xml file to export the course by clicking the "Browse" button.  

5. Click ‘OK’ button to export the course. The basic course structure i.e. Lessons, 
Topic Pages, Assessments, Questions, Glossary will get exported to xml file.  

6. Click Cancel to cancel the operation.  

By default the complete course structure with question bank and glossary terms is 
exported to the XML. However, if you wish not to export these, you can simply deselect 
the options provided on the export screen.  

 

Below are the attributes of all the learning objects that are exported to XML: 

Course:  

1. Course title  

2. Course Author  

3. Course learner resolution  

Learning Unit: 

1. Learning unit title  

2. Learning unit Objective  

3. Learning unit prerequisite  

 



 Lesson: 

1. Lesson title  

2. Lesson Objective  

3. Lesson prerequisite  

Topic: 

1. Topic title  

Exercise: 

1. Question Type  

2. Question text  

Assessment: 

1. Assessment title  

2. Assessment Objective  

3. Assessment prerequisite  

Question: 

1. Question type  

2. Question text  

Question bank: 

1. Question type  

2. Question text  

Glossary: 

1. Term  

2. Description  

Import from .csv file 

 
Elicitus allows you to import questions from .csv file. If you already have existing 
questions in Excel  or database format, you can easily import them in Elicitus. You can 
import the questions of type  Multiple choice, Fill in the blanks, True/ false and Multiple 
text entry. 
 
To import the questions using .csv file, 
 
1. Click on menu File-->Import-->Import questions from .CSV File…  
 
 
 
 



 
2. Clicking on the menu opens a dialogue where you need to select the .csv file from 

which you  want to import the questions in Elicitus question bank.  

 

3. Note that you need to create the .csv file in a specific format. You can see the exact 
format of  the .csv file by clicking on "View Example" button on the dialogue. (See 
also: .csv file format).  

 
4. Select the .csv file to be imported by clicking the "Select File" button.  

 
5. Click 'Import' button to import the questions. All the questions are imported in the 

question bank.  Note that if a question with the same question text already exists in 
the question bank, a  duplicate question is created.  

 
6. Click Cancel to cancel the operation.  
 

.CSV file format 

 
Elicitus allows you to import questions from .csv file. If you already have existing 
questions in Excel  or database format, you can easily import them in Elicitus. You can 
create the CSV file  using  Microsoft® excel or directly start typing in Notepad. We 
recommend the use of Excel. Once the file  is created in Excel, simply save it as .csv file 
using the 'Save As' option of Excel. 
 
To import the questions using .csv file,  
1. Each question needs to be written on a separate line in the csv file.  

 
2. Each question contains 8 fields such as Question Type, Question Text, No of choices, 

Answer  Text, Choice1, Choice2, Choice3, Choice4.  

 

3. Enter the value for Question Type. You can import questions of type Multiple choice, 

Fill in the  blanks, True/ False and Multiple text entry. For Multiple choice, enter the 
type as M, enter F for  Fill in the blanks, T for True/ False and ME for Multiple text 

entry. The field is not case sensitive.  
 
4. Enter the Question Text.  

 
5. Enter number of choices in the field No of choices. For Fill in the blanks type of 

question and  rue/ False question, the number of choices should be left blank.  

 
6. For Multiple choice question, the number of choices need to be between 2 to 5 and 

Multiple text  entry question, it should be between 1 to 5.  

 
7. Next, enter the Answer Text for the question. For True/ False question, the answer 

text is T if  the answer is True and F if the answer is False. The field is not case 
sensitive.  

 

8. Enter the values for Choice1, Choice2, Choice3 and Choice 4. Note that the number of 

choices  should be equal to number of choices plus answer text. Therefore, for 

example if you have a  Multiple choice question with 4 choices, enter number of 

choices as 4. Enter the answer text in  the Answer Text column and enter the values 

for Choice1, Choice2 and Choice3.  

 
 



 

Example: 
 
T,This True and False type of question,,T,,,,,  
F,This is Fill in the blanks type of question,,Correct answer,,,,,  
M,This is Multiple choice type of question,5,Correct answer,Choice 2,Choice 3,Choice 
4,Choice 5,  ME,This is Multiple text entry type of question,5,Correct answer,Choice 
2,Choice 3,Choice  4,Choice 5, 
 
 
 
 
 
 
 
 
 
 
 

Import Glossary terms from .csv file: 

Elicitus allows you to import glossary terms from .csv file. If you already have existing 
terms in Excel format, you can easily import them in Elicitus. You can create the CSV file 
using Microsoft® excel or directly start typing in Notepad. We recommend the use of 
Excel. Once the file is created in Excel, simply save it as .csv file using the 'Save As' 
option of Excel. 

To import the glossary terms using .csv file,  

1. Each glossary term needs to be written on a separate line in the csv file.  

2. Each glossary term contains 2 fields such as Term and its meaning.  

3. Enter the text for Term  

4. Enter the Meaning Text for the respective Term.  

Example:  

 

 

 

 



 

COURSE LOCALE SETTINGS 
 
When you are creating a course in any language other than English, you need to set 
Elicitus for that  particular language. The locale settings option allows you to do language 
specific font and other  settings. These settings are required to ensure that Elicitus 
software accepts the characters of that  language. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

To change the language and other course locale settings: 
 
1. Select the language for your course using the selection box on the top. The box 

shows the list of  languages installed on your machine. By default, the course is 
created in English language.  

 
2. Select the font for the course by clicking the 'Change' button. By default, Arial font is 

used.  

 

3. The list on the left shows various areas such as course outline, topic pages etc in the 
published  output where Elicitus uses Elicitus standard text and messages. If you wish 

to change the  standard text and messages in those areas, click on the respective link 
on the left.  

 
4. The left hand column of the table shows the Elicitus standard text and the right 

hand column  shows the text in the language you have selected using the selection 
box above.  

 
 
 



5. To change the text, click on the respective row in the column on the right. Clicking on 
it will allow  the editing of text.  

 
Note that these settings are for particular course. Therefore, if you wish to reuse the 
same settings  for multiple courses, use the option of save to file and load from file. 

 
To save your language font settings and changed text to a file for future use, click on 
'Save to file'  button. Later on, you can load the same settings using 'Load from file' 
option. 

 

PUBLISHING A COURSE 

Publishing a Course 

 
After you create a course, you can publish it; i.e. convert it into a set (folder) of HTML 
pages that can  be copied to a CD or hosted on your intranet or the internet for viewing 
by you or the learners. 

 

Elicitus will do this conversion with the global formatting for the course and the output 
settings you  had specified. You can, however, change all these course preferences 
except the screen  resolution while publishing the course. Note: Previously defined course 
preferences will not be  overwritten. That is, when you open the course after publishing 
it, the previously specified course  preferences will apply. 
 
If the course is published without the Slide Show format, the course outline is shown as 

the first  page to the learner. When the learner progresses through the course, all the 

learning units, lessons,  assessments and topic pages visited by the learner are shown as 

marked to indicate that he has  already viewed those. When the course is published to for 

viewing on CD ROM or website, the  status is maintained for a particular session of the 

learning. The status is reset when the course is  closed. When the course is launched 

through LMS, the status is maintained across the sessions. 
 
You can choose to publish with AICC Level 1, SCORM 1.2 or SCORM 2004 compliance 
 
If you choose to publish with SCORM 1.2 compliance you have two options:  
• You can publish with course level SCO (Sharable Content Object). In this case the 

course is  trackable on the LMS. The published course will be available in the 
SCORM_Course_Level  subdirectory of Publish directory in the course's folder.   

• You can publish with Lesson level SCO. In this case, each lesson is trackable on the 
LMS. The  published course will be available in the SCORM_Lesson_Level subdirectory 
of Publish  directory in the course's folder.  

 
 
NOTE: If the score for each assessment has to be tracked, publishing with Lesson level 
SCO is  recommended. 
 
 

 

 
 

 



 

If you choose to publish with AICC Level 1 Compliance you have two options:  
• You can publish with course level Assignable Unit. In this case the course can be 

launched and  tracked by an AICC level 1 complaint LMS. The published course will be 
available in the  AICC_Course_Level subdirectory of Publish directory in the course's 
folder.   

• You can publish with lesson level Assignable Unit. In this case each lesson is trackable 
on  the  LMS. The published course will be available in the AICC_Lesson_Level 
subdirectory of Publish  directory in the course's folder.  

 
NOTE: If the score for each assessment has to be tracked, publishing with lesson level 
Assignable  Unit is recommended. 
 
If you choose to publish with SCORM 2004 compliance you have two options:  
• You can publish with course level SCO (Sharable Content Object). In this case the 

course is  trackable on the LMS. The published course will be available in the  
SCORM2004_Course_Level subdirectory of Publish directory in the course's folder.   

• You can publish with Lesson level SCO. In this case, each lesson is trackable on the 
LMS. The  published course will be available in the SCORM2004_Lesson_Level 
subdirectory of Publish  directory in the course's folder.  

 
In all cases the course will open for viewing in the default browser of the machine on 
which it is  viewed. 
 
NOTE: To view a course properly, the machine should be loaded with Internet Explorer 

version 5.0  and above. If the course contains audio/visual elements, the machine should 

have the required  software (such as Windows Media Player) to view these elements. If 

the fonts used in the course  are not available in the machine, the course will be 

displayed in default fonts of the browser. 

 
If you choose to publish the course in Slide Show format, the course explorer, 
prerequisite box and  learning objective box is not shown. Apart from these, all the other 
objects on the course  outline are  shown on publishing the course. 
 
In case of standard compliant publishing: 
 
Course Level publishing: 
 
The course outline is shown as per your design. 
 

Lesson Level publishing: 
 

• A separate course outline page is generated for each lesson or assessment. If you 
choose to display the course explorer, the course explorer shows only the Topics 
from that particular Lesson. In case of assessments, it shows the name of the 
assessment and a link below it with the title “Click here to view the assessment”. 

• If the course outline contains links to different Shareable Content Objects (SCO), 
the links referring to that particular SCO are active, while others show a message 
that the learning object cannot be launched. 

 
 
 
 



 
For example, the course outline contains links to 3 SCOs as SCO1, SCO2 and SCO3 and 
the publishing is done at the Lesson Level SCO. 
 
In such a case, a separate course outline for the 3 SCOs is generated. 
 
The course outline for SCO1 has links for SCO2 and SCO3. The course outline for SCO2 
has links for SCO1 and SCO3, while the course outline for SCO3 has links for SCO1 and 
SCO2. 
 
When the learner clicks on the text hyperlinks a message is shown as “This link is 
provided to a different learning object which cannot be launched from this learning 
object.” If the link is provided through a button/hotspot, the links are inactive. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To publish a course: 

 

1. In the File menu click Open OR click Open Course icon on the toolbar. 
2. Click course file name. The Course Explorer wndow will open. 
3. In the File menu click File and then click Publish. This opens a dialog box to 

confirm output settings. 
4. To publish with SCORM 1.2 compliances, select Publish with SCORM 1.2 

Compliance, then select SCORM 1.2 Lesson level SCO or SCORM 1.2 Course level 
SCO. 

 
 
 
 



 
5. Click Publish to publish the course and Cancel to cancel the publishing. 

The course is now ready for copying to a CD or distribution via your intranet or the 

internet. 

Viewing a Course 

 
To view a course properly, the machine should be loaded with Internet Explorer version 
5.0 and above or Netscape 7.02, Netscape 7.1 or Netscape 7.2 or Firefox browser. If the 
course contains audio/visual elements, the machine should have Windows Media Player. 
For listening to the audio in Netscape 7.02 or Netscape 7.1, Quick Time 6.0 is required. 
Audio files will play in Internet Explorer if Windows Media Player is the default audio 
player. If the fonts used in the course are not available in the machine, the course will be 
displayed in default fonts of the browser. 
 
The course will be displayed with formatting and settings specified during the creation of 
the course. If you had chosen not to display course in slide show format, the course will 
open on the learner’s screen with the course outline, and the learner will have to click on 
lessons/topics to view them. If you had chosen to display course in slide show format, 
the course will open with the first topic page of the first lesson. 
 
The learner will be able to navigate through the course, from one topic page/lesson to 
another, using all the icons you have selected. Exercises and assessments will be 
displayed as explained in Viewing Exercises and Viewing Assessments respectively. 
 
In this way the learner will be able to view the course in the manner you have designed 
and structured it. 
 
All the courses published through Elicitus are compliant with Section 508 guidelines. 

Course upload to server 

 
The course upload option of Elicitus allows you uploading your published course files to a 
server using FTP (File Transfer Protocol). 
 

1. To open the course upload dialogue, click Tools-->Upload to server 
2. Enter the Host name, user name, password and the directory name where you 

wish to upload the course. By default, the port number is 21. Change the port 
number if required. 

3. Select the folder which you wish to upload. The list shows the various folders 
depending on the options using which the current course is published. 

4. Select the appropriate folder and click Upload to upload it to the FTP. 
5. Click Cancel to cancel the operation. 

EXITING ELICITUS 

 

Exiting Elicitus 
 
To exit elicitus: 
 
• On the main menu click File, and in the popup menu click Exit. 


